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Dans un monde numérique où presque tout
n'est que trucage ou ruse, les infographistes
souhaitent constamment plus d'effets ou mo-
dèles plus réalistes les uns que les autres,
truqués ou non. En particulier lorsqu'on touche
à la fourrure, cheveux, simulations de fluides,
et simulateurs de textiles réalistes, pour n'en
citer que quelques-uns.

Et alors que bon nombre d'animations super-
bes ne font pas usage de techniques, d'outils
et d'effets hauts de gamme, à un moment ou
un autre, chaque infographiste a envie de
jouer avec ces outils, sans autre raison que
«parce que c'est cool ! »

Les infographistes comprennent bien que tout
voeu de nouvelle fonctionnalité ne peut pas
être exaucé, mais heureusement pour nous,
les codeurs de Blender sont très doués pour
nous offrir ces fonctions autant que possible.

Oui, nous !

Le projet Peach (Big Buck Bunny) a apporté
quelques très bonnes améliorations au systè-
me de particules, permettant d'obtenir de la
fourrure/des cheveux vraiment magnifiques.
Lorsqu'ils sont bien réglés, on a tout simple-
ment envie d'aller les toucher.

Après des années de développement, notre
simulateur de textiles, longtemps attendu, a
fait son apparition. Le nouveau module de vê-
tements va annoncer un nouvel âge d'images
de test remplies de vêtements joliment drapés,
de drapeaux ondoyant et de toutes sortes de
tissus virevoltants.

Et qui peut résister à la tentation d'élaborer
une inondation massive ou une scène de ras-
de-marée avec des vagues s'écrasant partout?
Ou mieux encore, créer une harmonieuse scè-
ne de fluides?

Dans ce numéro, nous couvrons non seule-
ment l'utilisation de ces outils géniaux mais
aussi la façon d'élaborer quelques effets très
sympathiques. Allez donc chercher votre chaise
préférée et mettez vous en place pour une
bonne lecture.

Joyeux blend!

sandra@blenderart.org

Sandra Gilbert
Rédacteur en chef

EDITORIAL 3
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Big Buck Bunny:
Mon Dieu ! C'est arrivé si vite. Je ne m'attendais pas à ce que
mon DVD arrive aussi tôt. J'avais d'autres choses de prévues
ce jour là, mais je n'ai pas tardé à regarder BBB. Je ne pou-
vais pas attendre !

Je ne vais pas révéler l'histoire pour ceux qui ne l'ont pas
vue, je dirai simplement que je l'ai trouvée très drôle. Les
personnages avaient beaucoup de personnalité, et c'était très
amusant de regarder leurs expressions changer alors qu'ils
bougeaient et interagissaient les uns avec les autres.

Le style visuel de BBB était tout simplement magnifique. Tous
les animaux avaient l'air si duveteux et velus que j'avais en-
vie de les écrabouiller. Les couleurs et l'environnement
étaient doux comme dans un rêve. Vous pouvez être sûrs
que je vais creuser tous les fichiers de production pour dé-
couvrir tous les secrets de texturage et de matériaux.

En fait, je vais étudier les fichiers de production à fond
(comme tout le monde, j'en suis certain) pour voir comment
ils ont obtenu non seulement les matériaux et la fourrure,
mais également l'éclairage.

Je n'ai pas encore trouvé le temps de regarder tous les fi-
chiers et extras du DVD, mais un rapide coup d'oeil m'a assu-
ré qu'il y avait beaucoup à voir. Si vous n'avez pas encore
commandé votre DVD, je vous encourage à le faire dès que
possible. Vous ne le regretterez pas.

Nouveaux jouets à essayer:
Bien que je suive de près la progression et le développement
de Blender, mon emploi du temps ne me donne pas souvent
de temps pour jouer avec les compilations de test. Ce qui est
malheureux, étant donné le nombre impressionnant de nou-
velles fonctionnalités et/ou d'améliorations qui sont ajoutées
presque quotidiennement. Pour ne pas arranger les choses,
même lorsque je pose mes mains sur la toute dernière ver-
sion officielle, je n'ai pas toujours le temps de vraiment m'as-
seoir et de jouer avec les nouvelles fonctions. Comme
beaucoup d'entre nous, j'explore ces outils lorsque j'en ai

besoin pour mes projets. Et récemment, mes projets n'ont pas
vraiment nécessité d'outils poussés. C'est le comble (note à
moi-même : penser à de meilleurs projets pour pouvoir jouer
avec les nouvelles fonctions) !

L'arrivée et la sortie de Blender 2.46 n'a pas augmenté mon
volume de temps libre, mais les nouveaux outils amusants
étaient trop tentants pour pouvoir résister. Et donc, après un
rapide parcours de mes vieux fichiers pour trouver un modèle
convenable pour faire des tests dessus, je me suis assis pour
m'amuser un peu avec Blender. Chut ! Ne le dites à personne,
ils croient tous que je travaille sur quelque chose de produc-
tif.

Voici quelques-unes de mes impressions. Il ne m'arrive pas
souvent de m'asseoir et d'appuyer sur les boutons pour voir
ce qu'ils font, donc ça pourrait prendre un moment.

Quelques temps plus tard... Okay, 2-3 heures plus tard (je
m'amusais bien !).

Le modificateur Cloth : Même si je ne suis pas styliste,
j'ai passé un bon moment à jouer avec un poncho basique
(un simple cercle, subdivisé et reformé un tout petit peu). Ce
n'était pas un test très fantaisiste, mais c'était très marrant de
jouer avec les paramètres par défaut et de le regarder tomber
et se plier autour de mon petit personnage. J'ai réussi à obte-
nir de bons résultats avec peu voire pas du tout de réglages ;
utiliser simplement les pré-réglages fournis créait un poncho
joliment drapé. .

C'était intéressant de voir comment les différents pré-réglages
agissaient et variaient de l'un à l'autre. Mon poncho était
sympa, mais même moi, je ne pouvais pas être divertie plus
longtemps par un poncho qui tombait. J'ai donc évolué vers
un immonde déguisement en forme de robe et j'ai ajouté un
peu de vent. Cela m'a diverti pendant un bon moment. J'arri-
vais à voir la robe voleter au vent sous n'importe quel angle
(oui, je suis facile à divertir). La soie était ma préférée. Elle
avait une jolie façon de glisser qui faisait couler le vêtement
sur le personnage. Le caoutchouc était assez amusant lorsque
le vent était présent, car il rebondissait sur le ventre de mon
personnage et virevoltait un peu autour.

Tous les animaux ont l’air
si doux et poilu que je

Je voulais juste les toucher
et les caresser.
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Il y a des options pour des textiles personnalisés, mais hon-
nêtement je pense que la plupart des besoins sont couverts
par les pré- réglages. En particulier si vous ne faites que fure-
ter comme moi.

Fourrure/Cheveux (système de particules): au tour des che-
veux et de la fourrure. Comme la plupart de mes personnages
sont des animaux de toutes sortes, j'attendais avec impatien-
ce de pouvoir jouer avec le nouveau système de particules.
Une rapide recherche d'instructions m'a amené sur un tutoriel
en élaboration. Cela m'a donné quelques bons conseils pour
obtenir un bon système de fourrure qui tienne la route ; ça
m'a donné un point de départ. Mon modèle a terminé avec
l'air d'un cousin de BigFoot (le Yéti des Rocheuses américai-
nes), mais il était velu au moins. Quelle grosse marrade ! (:-D)
Les brosses pour éditer les cheveux m'ont occupé pendant un
moment à styliser les cheveux. Il semblerait que j'aie vrai-
ment besoin de prendre quelques leçons de coiffure... C'était
un mauvais jour pour les cheveux de mon petit bonhomme.

Je comptais explorer plus de nouvelles fonctionnalités, mais
j'ai passé tellement de temps à m'émerveiller regarder tomber
un vêtement et coiffer des cheveux que très vite, il fut temps
de retourner à toutes ces autres choses que j'étais supposé
faire.

Il y avait d'autres outils que je voulais vraiment essayer : édi-
tion UV, Baking de rendu, Bone Heat weighting et les amélio-
rations d'affichage des armatures... Mais je devrai retourner à
ces tests plus tard et jouer un peu quand j'aurai plus de
temps, ou bien quand personne ne regardera.

FAQ ManCandy:
Ces derniers mois (okay, sûrement plus que ça), j'ai tenté
d'apprendre le rigging et l'animation. Je voudrais vraiment
étendre mes compétences en animation, d'une simple anima-
tion d'objets jusqu'à l'animation de personnages. J'étais donc
vraiment excité à propos du DVD FAQ ManCandy. J'ai économi-
sé et je l'ai finalement commandé. Après avoir patienté pen-
dant les habituelles 2-3 semaines de temps de livraison (il
semblerait que je vis au bout de la Terre lorsqu'il s'agit de
livraisons), il est finalement arrivé. Yes !!!

J'étais si excité que je n'ai pas pu résister à la tentation d'in-
sérer le DVD dans mon ordinateur pour y jeter un oeil, même

s'il y avait de nombreuses choses que j'étais censé faire. Gra-
ve erreur, le simple fait de parcourir le DVD pour en faire suc-
cintement le tour m'a donné envie de m'asseoir et de tout
dévorer. Mais j'avais vraiment, vraiment des choses à faire.
Galère ! Quelle galère !

Soupir... Je me suis donc acquitté de toutes les choses qui
devaient être accomplies. Une semaine a passé, puis deux.
Toujours pas le temps de regarder mon nouveau DVD. Quelle
misère. Au point où on en est, je ne le regarderai jamais...
Puis soudainement j'ai eu une idée géniale. J'ai embarqué
mon DVD, mon vieux laptop et je les ai tous deux emmenés
au bureau, où je les ai promptement mis en place et com-
mencé le DVD. J'ai écouté le DVD pendant que je travaillais sur
mes projets. Problème semi-résolu.

Je n'ai toujours pas vu grand chose du DVD (juste des bouts
de çà de là), mais je l'ai écouté en entier de nombreuses fois.
Comme je l'ai dit, ce n'est pas une solution parfaite, mais
j'apprends un peu. Accordé, il faut encore que je le regarde
en entier, mais ça suffira pour l'instant.

J'admire depuis longtemps le talent de Bassam et sa créativi-
té, et après avoir regardé le DVD, j'ai été heureux de découvrir
qu'il est aussi bon professeur et même plutôt drôle. Son style
pédagogique est similaire à une conversation en profondeur
avec un ami. Il explique tout de manière simple et désinvolte.
Une chose que j'ai vraiment appréciée est la façon qu'il a de
vous montrer non seulement comment et pourquoi mettre en
place les choses correctement, mais aussi ce qui se passe si
vous faites mal quelque chose ou si vous l'oubliez. Il a même
laissé quelques unes de ses erreurs dans les vidéos et ensui-
te montre comment les corriger.

Bassam a rassemblé une somme impressionnante d'informa-
tions dans chaque vidéo. Et alors qu'elles forment bien enten-
du un tout, elles peuvent tout aussi bien être prises à part
comme des cours complets. J'ai déjà écouté le DVD plusieurs
fois et je l'écouterai et le regarderai encore de nombreuses
fois. A chaque fois que je « regarde » un morceau, j'apprends
quelque chose de nouveau et ma compréhension du rigging
croît, ce qui ne peut qu'être positif.

Le DVD FAQ ManCandy valait bien son prix et l'attente. Mainte-
nant, si seulement je pouvais simplement trouver le temps de
faire quelque chose de mes nouvelles connaissances...
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Blender 2.46
Le travail du semestre passé – et
les efforts du projet du film
ouvert (open-film ?) « Big Buck
Bunny » - ont entraîné un en-
semble de fonctions grandement
améliorées, désormais sous
Blender 2.46, la « version du
Lapin  » !

Cette version comporte un nou-
veau système de particules avec

des outils de peignage de fourrure et de cheveux, un rendu
rapide et optimal de la fourrure, un système de déformation
de maillage pour le rigging avancé de personnages, la simu-
lation de textiles, de l'occlusion ambiante rapide, un nouvel
explorateur d'images, et ce n'est que le début. Jetez un coup
d'oeil à la liste conséquente de fonctionnalités.

Videos des fonctionalités de la 2.46
Un artiste Blender des forums francophones Blender du Blen-
der Clan a publié un ensemble de vidéos, montrant com-
ment utiliser quelques-unes des nouvelles fonctions de
Blender 2.46. Environ 20 vidéos sont disponibles au téléchar-
gement !

Voici une courte liste des vidéos disponibles:

· démonstration du modificateur explosion.

· démonstration du modificateur Meshdeform.

· quelques-uns des nouveaux nodes de composition en
démonstration.

· démonstration de la fonction timbre de rendu.

· démonstration du nouveau système de cheveux
(particules), avec Traven dans le rôle d'un remarquable
coiffeur.

· démonstration de la fonction textiles (pas très original,
mais au moins elle existe).

· changements dans le système de dépliage UV (fusion
des modes édition et UV)

· démonstration des ombres douces avec un Spot en
lancer de rayons

· démonstration du Bone Heat Weighting et démonstra-
tion de la bibliothèque de pose (et quelques autres
choses)

Ne manquez pas d'aller voir la liste complète des télécharge-
ments disponibles, il y a beaucoup à voir et à apprendre.

Packagers requis
pour le Projet
Apricot !
Nous nous prépa-
rons à ouvrir notre
dépôt pour que le
public ressente le
vrai pouvoir de
l'Open Source. En ce moment, nous avons besoin de person-
nes qui nous aideront à faire des versions pack pour
GNU/Linux, Windows et OS/X. Donc, si vous avez le temps, si
vous vous y connaissez en packaging / pistage / résolution
de bugs, écrivez-nous ! Postulez à : res[-a-t-
]crystalspace3d.org

Projet Peach: BIG BUCK BUNNY
Tous les DVDs précommandés ont été envoyés par voie mari-
time et font leur bout de chemin à travers le monde, vous
pouvez suivre les dates d'arrivées sur la carte de frappr.

La sortie Internet de BBB et des fichiers de production s'est
très bien déroulée. Vous trouverez une liste de tous les mi-
roirs et torrents sur le site de BBB.

BLENDER NEWS
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Introduction
Les matériaux organiques font probablement
partie des plus difficiles à élaborer, car leur
réalisme ne repose pas exclusivement sur la
qualité de leurs textures. La peau en images de
synthèse a souvent l'air en plastique, et, lors-
que le subsurface scattering est activé, elle a
tendance à ressembler à de la cire. Ces derniè-
res semaines, j'ai essayé d'atteindre le réalisme
sur des rendus de peau, ou tout du moins,
d'obtenir un shader de peau qui n'ait pas l'air
affreux au rendu.

Après quelques recherches, j'ai commencé à
construire une sorte de shader de peau à cou-

ches multiples, pour pouvoir prendre en compte les différen-
tes couches de la peau humaine. Dans Blender, ça signifie
utiliser un matériau pour chacune des couches de la peau
(épiderme, derme, etc), puis les combiner au sein de l'édi-
teur de noeuds de matériaux afin d'obtenir le matériau final.

PREMIERE PARTIE : LES COUCHES DE DIFFUSION
Etape Une: La Strucure de la Peau

Tout d'abord, occupons-nous de la partie diffuse de notre
matériau : nous mettrons en place les éclaircissements spé-
culaires séparément. Avant d'essayer de simuler l'aspect de
la peau, nous devons comprendre sa composition:

· La couche supérieure de la peau est l'épiderme, qui dis-
perse légèrement la lumière. Il est jaune/gris. Sous les
pieds, par exemple, l'épiderme est plutôt épais, c'est pour
cette raison que la peau y apparaît presque jaune.

· Vient ensuite le derme – il est presque rouge, à cause du
sang qui y circule. A la différence de l'épiderme, il disper-
se beaucoup la lumière.

· Bien que les tissus sous-jacents (les muscles, les organes,
le cartilage, etc) soient presque imperceptibles, nous al-
lons devoir simuler une sorte de « dispersion de dos » -

lorsque les oreilles sont éclairées par derrière, par exem-
ple, elles apparaissent rouges. La dispersion de dos aurait
pu être faite au sein de la couche dermale, puisqu'il exis-
te un facteur « de dos » dans le panneau SSS de Blender,
qui permet de régler led SSS de devant et de dos séparé-
ment. Mais en fin de compte, on obtient plus de contrôle
en séparant la dispersion de dos de la dispersion du der-
me.

· Une dernière note à propos de la structure de la peau :
en théorie, il n'y a rien au-dessus de l'épiderme. Cepen-
dant, l'utilisation du SSS (même d'une manière très subti-
le) va tendre à gommer les reliefs de vos modèles
texturés. C'est pour cette raison que nous allons devoir
appliquer une autre couche, qui sera une couche diffuse
sans dispersion. En procédant de la sorte, vous serez en
mesure de conserver tous les reliefs de vos textures, et
cette couche seulement sera texturée (en ce qui concerne
les couches diffuses). (NB : par la suite, je me suis rendu
compte que texturer l'épiderme en plus, et même le der-
me, augmentait le réalisme...)

· Regardez simplement le schéma, qui résume ce que nous
devons simuler. Sachant tout cela, nous voilà en mesure
de commencer à Blender, et à régler nos matériaux.

ATELIER 3D: Ombrage de Peau avec sss multi-couches
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Le subsurface scattering, également connu sous le nom
de SSS, est un phénomène qui a à voir avec la
translucidité de certains objets, c'est-à-dire qu'ils ne sont
ni complètement réflectifs, ni transparents. Les rayons
de lumière ne font que rebondir sur les surfaces
réflectives. Ils passent à travers les objets transparents
uniformes, en étant déviés deux fois (lorsqu'ils frappent
la surface, et lorsqu'ils ressortent de l'objet). Mais les
objets translucides dispersent la lumière incidente, en
déviant les rayons plusieurs fois d'une manière
chaotique jusqu'à ce que les rayons s'échappent, si bien
que la surface a l'air très douce. Les matériaux qui se
comportent de la sorte sont, par exemple, le lait, la cire,
les pommes de terre, etc. Beaucoup d'objets organiques
ont tendance à disperser la lumière.

Subsurface Scattering



Étape Deux: La Diffu-
sion Sans Dispersion

L’éclairage: avant de
commencer le sha-
ding, nous devons
mettre en place une
scène de test rapide,
et néanmoins utilisa-
ble. J'ai utilisé un mo-
dèle de tête fourni par
Maqs sur les forums
de BlenderArtists.org,
et il m'a aussi donné
la permission de mon-
trer son modèle dans
cet article

Il mérite tous les remerciements, car il m'a aussi beaucoup
aidé à construire mon shader. Vous pouvez aussi utiliser la
tête de singe par défaut à la place du modèle de tête de
Maqs ([Espace] Add>>Mesh>>Monkey), ou même une tête im-
portée de MakeHuman (File>>Import>>Wavefront).

Mon éclairage est plutôt simple : une lampe principale
(Add>>Lamp>>Lamp) pour illuminer la tête (avec les ombres
douces en lancer de rayons activées) et une lampe « Rim »
avec une teinte légèrement bleutée éclairant l'objet de derriè-
re afin de faire ressortir les contours.

Nous pouvons à présent commencer le shading en lui-même.
Ajoutez un nouveau matériau à votre objet (dans le panneau
des matériaux, « add new »), et nommez-le «
diffusion_sans_dispersion » par exemple. Donnez lui une
couleur naturelle de peau, et réglez la réflexion diffuse en
Oren-Nayar. Le shader diffus Oren-Nayar tiens compte, lors du
rendu, des microfacettes hypothétiques à la surface, ce qui
permet de simuler des surfaces rugueuses comme de l'argile,
des vêtements, des rochers secs, etc.

Cela aide donc à obtenir une ombrage plus naturel. N'oubliez
pas de mettre la glissière Spec à 0.00, puisque nous nous
occuperons des spéculaires plus tard. Si vous avez peint de
belles textures pour votre modèle, appliquez les maintenant,
excepté pour les textures de spéculaires. Il est important de
comprendre que, bien que l'épiderme soit la couche supé-
rieure de la peau, nous ne le texturerons pas, car l'effet de
translucidité rendrait les détails trop flous.

ATELIER 3D: Ombrage de Peau avec sss multi-couches 8
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Étape Trois : La Couche Epidermale

Au tour de l'épiderme à présent. Nous devons construire un
shader ressemblant à un cadavre exsangue, puisque le sang
coule principalement dans le derme. En fin de compte, l'épi-
derme doit être gris / jaune, et nécessite un effet de SSS plu-
tôt subtil. Après avoir ajouté un autre matériau appelé «
Epiderme », donnez lui une couleur gris jaune comme si
c'était de la peau déssaturée, et jetez un oeil aux paramètres
que j'ai utilisés pour le SSS (je ne détaillerai pas tout, car nous
avons à régler trois couches utilisant du SSS ; je préfère utili-
ser des captures d'écran). Gardez simplement à l'esprit que
pour chaque couche, le rayon du rouge sera deux fois plus
grand que le rayon du vert, et le rayon du bleu restera deux
fois plus faible que le rayon du vert (en se basant sur des
mesures scientifiques).

Une rapide note sur l'échelle du SSS (« Scale ») : en théorie,
nous devrions utiliser exactement le même facteur d'échelle
pour toutes les couches incorporant du SSS, puisque notre
objet a une taille fixe. Néanmoins, comme les rayons de SSS
de l'épiderme, du derme, et du « SSS de dos » diffèrent forte-
ment, cela nous amènerait à manipuler de minuscules rayons
de SSS pour l'épiderme, et d'énormes rayons de SSS pour les
autres couches. Opérer de la sorte serait imprécis, et parce
que nous travaillons pas-à-pas, c'est en fait mieux de régler

chaque couche séparément sans se poser la question de sa-
voir si le facteur d'échelle est le même pour chacune.

Étape Quatre : La Couche Dermale

Dans la réalité, le derme est rouge ou orange, à cause du sang
qui y circule. Lorsqu'il sera temps de combiner toutes les cou-
ches diffuses, nous devrons être capables de déceler le sang
sous-jacent. Par conséquent, ajoutez un nouveau matériau,
appelez le « Derme », et donnez lui une teinte plutôt rouge
orangée. Contrairement à l'épiderme, le derme doit beaucoup
disperser la lumière, nous devons donc utiliser des rayons de
SSS beaucoup plus grands. Regardez la capture d'écran pour
voir les paramètres que j'ai employé. Notez que nous mettons
le facteur « Back » à 0, car la dispersion de dos sera obtenue
sur un autre shader. Une fois encore, n'oubliez pas de mettre
la glissière Spec à 0.
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La couleur du SSS est réglée sur du bleu.
En effet, j'ai remarqué qu'utiliser du bleu

pour la couleur du SSS faisait prendre aux terminateurs
(les zones transitionnelles entre l'ombre et la lumière)
la couleur complémentaire, c'est-à-dire orange, et c'est
ce que nous souhaitons.

Note

Couche de l’épiderme
Couche du Derme



Étape Cinq: La Dispersion arrière

A présent, nous pouvons nous occuper de la dispersion arriè-
re. J'ai préféré la séparer de la couche dermale. De ce fait,
nous avons plus de contrôle sur l'effet de translucidité. Ajou-
tez encore un autre matériau appelé « dispersion_arrière »
par exemple, et réglez sa couleur sur du noir, pas totalement
pur – si votre shader ou texture a une zone de noir pur, rien
ne pourra être dispersé car n'importe quelle couleur multi-
pliée par du noir reste noire (le noir pur est codé par [0 , 0 ,
0]). Dans le panneau du SSS à présent, réglez la couleur du
SSS sur du rouge, et mettez des rayons de SSS plutôt larges.
Ca dépend en fait de la taille de votre modèle, dans mon cas,
je voulais voir un peu de rouge sur les oreilles, mais pas
trop, sinon cela aurait donné l'impression que le modèle était
minuscule.

Étape Six: Mixer toutes les Couches Diffuses à l'aide des
Noeuds de Matériaux

Allons-y : ajoutez un nouveau matériau nommé «
Shaders_combinés », et activez le bouton Node. Ouvrez l'édi-
teur de noeuds de matériaux, et dans celui-ci, chargez cha-
que matériau créé précédemment, avec
[Espace]>>Add>>Input>>Material. Faites ceci quatre fois, et pour

chaque node, assignez l'un des matériaux de la peau. A pré-
sent, il est temps de mixer toutes les couches ensemble.
Ajoutez un opérateur Screen de la sorte :
[Espace]>>Add>>Color>>Mix et changez la méthode de mixage
en « Screen » au lieu de « Mix ». Maintenant, reliez l'épider-
me à la première entrée de l'opérateur Screen, et reliez le
derme à la seconde entrée. Laissez le facteur de mixage à la
valeur par défaut qui vaut 0.5. A présent, vous pouvez procé-
der de même avec le matériau « dispersion_de_dos », en
utilisant un opérateur « Add » cette fois ci.

Le matériau de dispersion arrière doit être noir, excepté dans
les zones où le modèle est éclairé de derrière. En utilisant
l'opérateur « Add », nous sommes assurés que les zones
sombres du matériau de dispersion de dos ne changeront
rien au rendu, puisqu'ajouter du noir pur ([0 , 0 , 0]) ne chan-
ge rien. Prenez garde de bien régler le « Fac » sur 1.00, sinon,
la dispersion arrière ne sera pas complètement ajoutée. Bien
entendu, si vous remarquez que la dispersion arrière est trop
forte, vous pouvez facilement réduire le « Fac » plutôt que de
changer les paramètres originaux du SSS. Et enfin, combinez
la couche de « diffusion_sans_dispersion » avec les autres
matériaux en utilisant un autre opérateur « Screen ».

Cette fois ci, j'ai réglé le « Fac » à 0.60. Seul vous êtes en
mesure de décider si vous préférez voir une peau plutôt
translucide, ou au contraire plutôt réflective qui n'absorbe
pas beaucoup de lumière. Pour finir, reliez le node « Screen »
au matériau de sortie (« Output »).
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A propos du paramètre d'erreur : pour des rendus
tests, vous pouvez le mettre à environ 0.5, voire

même 1.0. Pour des rendus finaux, vous pouvez le descendre à
0.1, ou même 0.05 si vous le souhaitez, dans le cas de grands
rendus et/ou de calculs plus précis requis. Dans mes tests rapi-
des, je me suis décidé pour 0.2, car je voulais des rendus plutôt
propres sans avoir à attendre trop longtemps.
C'est tout en ce qui concerne les shaders diffus. Maintenant, il
nous faut les mixer tous ensemble dans l'éditeur de noeuds de
matériaux afin de rendre toutes les couches en même temps

Note

Dispersion arrière



Vous avez sûrement remarqué que j'ai inséré un contrôleur «
RGB Curves » (courbes rvb) après la réunion de l'épiderme et
du derme. En effet, c'est bien mieux de peaufiner la couleur
de la peau de cette façon, plutôt que d'avoir à changer les
paramètres du SSS dans le panneau des matériaux.

Une dernière chose à propos de l'opérateur « Screen » : en
théorie, nous devrions utiliser un opérateur « Mix » pour
combiner les couches, puisque nous voulons simplement que
les différentes couches apparaissent toutes ensemble. Cepen-
dant, l'opérateur « Screen » fournit de meilleurs résultats,
tandis que l'opérateur « Mix » tend à rendre la peau « plate
». Vous devriez aussi utiliser un opérateur « Screen », selon
moi, à condition que votre éclairage ne soit pas trop « extrê-
me », pour ainsi dire. Sous des conditions d'éclairage extrê-
mes, par exemple, une lumière solaire très puissante, utiliser
un opérateur « Screen » donnera un rendu des couleurs com-
plètement anormal. En fin de compte, que vous utilisiez «
Mix » ou « Screen » dépend de la spécificité de la situation.

Ca commence à rendre plutôt bien. Et pourtant, ça ressemble
encore à du caoutchouc. Visiblement, quelques spéculaires
font défaut. Passons donc à la partie deux !

DEUXIÈME PARTIE: AJOUTER DES ÉCLAIRCISSEMENTS

Étape Sept: Des Réflexions Spéculaires sur Deux Couches

Les éclaircissements que nous avons l'intention de simuler
proviennent de deux sources : les spéculaires de la peau (qui
sont assez larges et douces) et les spéculaires dues à la
sueur sur la peau, qui seront plus claires et concentrées. Les
deux termes spéculaires auront une teinte bleutée, afin de
contrebalancer la couleur jaune de la diffusion cutanée. Per-
sonnellement, j'ai choisi d'utiliser le shader spéculaire par
défaut Cook-Torrance, car il permet de simuler une sorte d'ef-
fet Fresnel, contrairement au shader Phong par exemple (les
reflets doivent apparaître plus brillants aux angles rasants).

Ajoutez un autre shader à votre modèle et nommez le «
Spéculaires_douces_Peau » par exemple. N'oubliez pas de
mettre la valeur « Ref » à 0.0, puisque nous ne nous occu-
pons plus de la diffusion. Vous pouvez aussi régler la couleur
de base de l'objet sur du noir pur.
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Lorsque l'on parle de
surfaces réflectives,

l'effet Fresnel est fréquemment impli-
qué. En effet, la réflectance de la plu-
part des surfaces n'est pas la même
à des angles rasants, comparée à la
réflectance de ces surfaces lorsqu'el-
les sont vues de face. On appelle
cela l'effet Fresnel
Vous pouvez voir des exemples de
ce phénomène en regardant une fe-
nêtre : à des angles rasants, vous ne
pouvez pas voir à travers, le verre
étant plus réflectif que lorsqu'il est vu
de face.

Note

Schéma de nodes sur la partie diffuse du shader



Ou bien, dans l'éditeur de noeuds, lorsque vous avez ajouté
vos matériaux, vous pouvez désactiver le bouton « Diff ». L'es-
sentiel est que ces shaders ne fournissent que des spéculaires.
Le shader spéculaire Cook-Torrance est activé. Comme nous
voulons que les spéculaires de la peau soient douces et larges,
mettez la valeur « Spec » à 0.1, et la valeur « Hard » à 10.

Après avoir réglé la couleur
spéculaire sur une teinte bleu-
tée, vous pouvez continuer en
créant un autre matériau qui
s'appellera «
Speculaires_franches_sueur »
ou quelque chose de similaire.
La seule différence est que la
glissière « Spec » est réglée
sur 0.3, et la valeur « Hard »
sur 30.

Étape Huit: Mixer les Termes
Spéculaires Avec la Diffusion –
Arbre Nodal Final

Les deux couches de spéculai-
res sont dé-

sormais prêtes. Sélectionnez votre matériau «
Shaders_combinés » et ouvrez l'éditeur de
nodes une fois encore. Commencez par ajou-
ter vos matériaux spéculaires au réseau no-
dal. Mélangez les deux shaders spéculaires
avec un autre opérateur « Screen » (comme
d'habitude, [Espace]>>Add>>Color>>Mix puis
réglez la méthode de mixage sur « Screen »).
Mettez le facteur Screen (« Fac ») à 1.0. Après
cet opérateur Screen, vous pouvez insérer un
autre contrôleur « RGB Curves », comme je l'ai
fait, car ça permet un contrôle plus rapide de
la luminosité des spéculaires.

Pour finir, ajoutez le dernier opérateur «
Screen », qui rajoutera les spéculaires au-des-

sus de la partie diffuse du shader. Mettez son facteur à 1.0.
L'image ci-dessus montre l'arbre nodal concernant la partie
spéculaire du shader, et la capture d'écran ci-dessous montre
le réseau nodal terminé.

Notre shader est maintenant prêt à l'emploi. Bien entendu, il y
a beaucoup d'aspects qui pourraient et devraient être amélio-
rés pour atteindre le photoréalisme. Si vous ne vous ennuyez
pas encore, peut-être voudriez-vous continuer à lire. La partie
trois vous attend !
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Schéma de nodes sur la partie spéculaire du shader

Schéma final des nodes - diffusion et spéculaire combinées



TROISIÈME PARTIE : ALLER PLUS LOIN
Dans cette partie, je tenterai de vous donner quelques trucs et con-
seils, un tour d'horizon de ce qui pourrait être amélioré dans le
shader que nous avons construit, et au-delà de ça, quelques con-
seils de rendu en vue de gagner en réalisme.

1. Des Éclaircissements Corrects à l'Aide des Réflexions Floues
en Lancer de Rayons

Vous avez dû remarquer plusieurs fois que les spéculaires ne sont
qu'une médiocre manière de simuler le comportement réel de la
lumière. En théorie, les éclaircissements apparaissent parce que
des objets plus lumineux que la normale sont réfléchis. Les spécu-
laires sont en fait une méthode peu coûteuse pour obtenir des
éclaircissements. Elles ne sont pas capables de réfléchir autre cho-
se que des lampes, et par dessus tout (dans Blender tout du
moins), les éclaircissements spéculaires ne correspondent pas à la
vraie forme des objets réfléchis.

Regardez simplement la comparaison à droite, et vous remarquerez
que, premièrement, les spéculaires ne réfléchissent pas l'environ-
nement (le plan orange et le ciel bleu). Deuxièmement, vous de-
vriez vous rendre compte à quel point la forme des spéculaires
devient étrange aux angles rasants. Elles apparaissent rondes, alors
qu'elles devraient prendre la forme d'un arc de cercle, exactement
comme sur le rendu avec les réflexions douces.

Et si nous essayions d'avoir des éclaircissements corrects à l'aide
des réflexions floues ? Bien entendu, ça sera coûteux en terme de
temps de rendu, mais au moins, nous obtiendrons quelque chose

de satisfaisant. Essayons donc. Tout ce qu'il nous faut faire est
ajouter un autre shader, qui utilisera uniquement des réflexions
floues, et ensuite, le combiner avec le shader original. Je vous lais-
se décider si vous voulez remplacer complètement ou partiellement
seulement les spéculaires, étant donné le temps de rendu néces-
saire.

Notre première considé-
ration est que, puisque
nous ne voulons que voir
des éclaircissements,
notre surface ne peut
pas être complètement
réflective. Par consé-
quent, comment allons
nous pouvoir observer
des éclaircissements
blancs si notre matériau
ne réfléchit que 50% de
la lumière ? Les objets blancs n'apparaîtraient que blancs à 50%,
lorsque reflétés à 50%. La réponse est simple : grâce au paramètre
« Emit », nous pouvons rendre des objets qui sont « plus blancs
que blancs ». De ce fait, nous aurons des éclaircissements satisfai-
sants sur une surface qui ne reflète pas toute la lumière. Jetez un
coup d'oeil au rendu ci-dessous, qui montre le reflet de trois plans.
Ces trois plans n'ont qu'une seule différence : leur valeur d'émis-
sion (Emit) augmente, de gauche à droite.

Si vous comptez utiliser les réflexions floues à la place des éclaircis-
sements spéculaires, ou tout du moins combiner les deux métho-
des, vous devez garder à l'esprit que les réflexions en lancer de
rayons ne montrent pas les Lampes. Vous aurez donc à mettre en
place des objets additionnels pouvant être réfléchis, tels que des
sphères pour les lampes standard (sources ponctuelles), des plans
pour les lampes de surface « Area ». Même des singes émetteurs,
ou n'importe quoi d'autre peut être nécessaire.

Vous devrez placer ces objets au même endroit et avec la même
orientation que les lampes, et sur un autre calque (si vous placez
une sphère à l'endroit exact d'une lampe avec les ombres activées,
bien entendu, il y aura des ombres partout, puisque la lumière ne
s'échapperait même pas de la sphère).
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Plutôt que de ren-
trer dans les dé-
tails des
paramètres à utili-
ser, j'ai fait une
capture d'écran des
valeurs que j'ai
employés pour
obtenir le rendu
suivant. Trente-
deux échantillons
forment un bon
compromis entre le
temps de rendu et
la qualité. Pour les
rendus finaux, vous
devriez utiliser 64
ou même 128 échantillons. Au delà de ces valeurs, le grain est
tellement indécelable que l'on peut à peine voir la différence.

Je crois que c'est tout
ce que l'on peut dire
sur les réflexions
floues. A présent, tout
ce que vous avez à
faire est injecter votre
nouveau shader dans
le shader de peau, et le
rajouter au-dessus de
la partie diffuse du
shader. Si vous voulez
plus de réalisme, vous
voudrez peut-être em-
ployer deux couches de
réflexions floues afin
de replacer les ancien-
nes spéculaires. Ça
serait logique, puisque
nous avons également

utilisé deux termes spéculaires dans notre arbre nodal original.

2. Améliorer davantage le shader

Le shader que nous avons construit est une matériau « généri-
que », qui est conçu pour s'adapter à beaucoup de situations.
Néanmoins, il peut être customisé, selon le type de peau que
vous voulez rendre. Par exemple, vous voudriez peut-être voir
une peau duveteuse. Dans ce cas, votre matériau doit avoir
l'air doux, avec une sorte d'effet Fresnel simulant les innom-
brables poils qui apparaissent davantage à des angles rasants.
Un tel effet peut être obtenu en jouant avec quelques noeuds
« Normal » et « Geometry » dans l'éditeur de noeuds maté-
riaux.

Ou bien, si vous ne souhaitez pas le faire avec des nodes, vous
pouvez tout simplement utiliser un shader diffus de type «
Minnaert » à la place du shader Oren-Nayar que j'ai choisi
d'utiliser pour la diffusion sans dispersion. Notez que l'effet de
« mise en valeur des contours » peut aussi être obtenu à l'aide
de réflexions floues en lancer de rayons prenant en compte le
facteur Fresnel. C'est à vous de peaufiner le matériau à souhait
: ce que je propose n'est qu'un squelette, un concept de base
que vous pouvez modifier et adapter à volonté.

Un autre idée à explorer : lors de la construction de notre arbre
nodal, tous les facteurs de mixage étaient fixés, mais vous
pourriez avoir envie d'utiliser des textures pour contrôler ces
valeurs de « Fac ». Par exemple, le facteur de « Screen » entre
le derme et l'épiderme est réglé sur 0.6, alors qu'il n'est pas
constant en réalité : sous vos pieds, la peau apparaît jaune
parce que l'épiderme est plutôt épais ; les lèvres apparaissent
presque rouges parce que l'épiderme est fin dans cette zone,
etc.

Rien ne vous empêchera de peindre une texture définissant
l'épaisseur de l'épiderme, et ensuite de l'insérer dans l'arbre
nodal afin d'obtenir l'effet désiré. Ou bien, vous pouvez laisser
les composantes de rouge de la texture de couleurs vous don-
ner une épaisseur épidermique « truquée ».
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3. Quelques conseils de rendu

Pour conclure, quelques trucs de rendu/post-traitement pour
augmenter le réalisme de vos rendus de peau.

Le premier conseil est plutôt
simple : afin d'améliorer le
contraste/l'éclairage de votre
rendu, vous pouvez utiliser un
noeud « overlay »
(superposition) en post-traite-
ment, en superposant le rendu
sur lui-même. Bien sûr, les cou-
leurs peuvent être peaufinées à
l'aide de courbes RVB, quelques
corrections de contraste, etc.

Un autre conseil que je donne-
rais est d'utiliser l'Occlusion Am-
biante (AO) ! En effet, la peau a
tendance à s'illuminer d'elle-mê-

me. Plus deux zones sont proches, et plus elles apparaîtront
saturées (orange, dans le cas de la peau), à cause des nom-
breux rebonds de la lumière entre ces deux surfaces. Et ce
qui est génial avec l'AO est que, dans une certaine mesure,
elle fournit les « valeurs de distance » des polygones rendus.
Vous avez juste à ajuster la passe d'AO pour qu'il soit orange,
et ensuite à le multiplier avec votre rendu, comme sur l'ima-
ge ci-dessous. Vous remarquerez par exemple que les pau-
pières et les lèvres ressortent mieux, pour ainsi dire.

Conclusion
En fin de compte, nous avons obtenu un shader plutôt réalis-
te qui vous aidera, je l'espère, à vous débarrassez de la peau
plastique vue d'ordinaire. Tout d'abord, je souhaiterais remer-
cier la communauté Blender, qui m'a donné de nombreux
conseils utiles. Et par dessus tout, merci à vous de m'avoir
lu. Il ne me reste plus qu'à vous souhaiter un « Happy Blen-
ding » !

Ci-dessous, quelques rendus tests montrant ce qui peut être
fait avec ce shader. Aucun post-traitement n'a été utilisé,
excepté pour l'effet glow.
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Quelques éclairages étranges sur le modèle de tête de Maqs:
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Le ô combien utile Bouddha de Stanford avec un look charnu, et son ami le dragon de Stanford:



Introduction
Comme n'importe quel effet atmosphéri-
que, créer de la fumée réaliste n'est pas
une tâche facile. Chaque type de fumée
nécessite une technique particulière. Si
vous voulez simuler une fumée de ciga-
rette, suivez le merveilleux tutoriel de
Meltingman disponible dans ce numéro
de BlenderArt. Il propose une méthode
facile qui donne des résultats convain-
cants. Mais si vous avez besoin d'un fu-
mée plus épaisse, vous devrez choisir
une autre technique.

Bien sûr, le meilleur outil que vous pou-
vez utiliser pour cela est basé sur la simulation de fluides
pour créer des mouvements et des voxels (NdT : Volume-
tric Pixel ou Pixel en 3D). Pour l'instant, Lightwave propose
un outil puissant pour créer ce genre d'effet, nommé
"Hypervoxel". Comme Blender ne dispose pas de ce type
d'outil et comme le rendu de voxel peut être un processus
qui prend beaucoup de temps, nous devons choisir une
autre méthode.

Depuis plusieurs années, les artistes travaillant dans l'in-
dustrie des effets spéciaux utilisent les systèmes de parti-
cules. Contrôler le flux de particules n'est pas le plus ardu,
la partie la plus difficile est de le rendre. De combien de
particules avez-vous besoin pour créer un mouvement de
sable réaliste comme dans le film Spiderman 3, dans la
scène de la naissance de l'Homme Sable ? Un autre exem-
ple : vous devez contrôler des milliards de particules pour
simuler une avalanche, comment rendre chaque flocon de
neige et comment lui donner le bon ombrage ?

Pour tous ces types d'effet, comme les nuages, la fumée,
les tornades, les chutes d'eau, les tempêtes de sable, une
météorite en feu, un avion qui s'écrase, une explosion,
etc... vous pouvez utiliser une merveilleuse technique
appelée "Sprites"... ou "Billboards" (Panneaux) dans Blen-
der. Voyons comment les utiliser.

A) Créer l'émetteur et les textures :

Étape 01:

Créer un nouveau plan en
cliquant sur Add >> Mesh >>
Plane, puis quitter le mode
Edit en appuyant sur la tou-
che Tab si besoin.

Étape  02:

Appuyer sur ALT+R et ALT+G
pour bouger et placer l'objet
"Plan" au centre de la scè-
ne.

Étape  03:

Appuyer sur la touche N
pour ouvrir la fenêtre
"Transform Properties". Ré-
duire l'échelle sur les 3 axes
(Scale X, Y et Z) à 0.725 et
entrer -4 dans Loc X.

Étape  04:

Appuyer sur la touche Tab
pour basculer en mode Edit
et appuyer sur la touche A
pour sélectionner tous les
vertices.
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Étape 05:

Appuyer sur la touche U et
choisir "Unwrap" pour générer
les coordonnées UV. Si l'émet-
teur n'a pas de coordonnées
UV, les "billboards" ne s'affi-
cheront pas correctement. Ap-
puyer de nouveau sur Tab pour
quitter le mode Edit.

Étape  06:

Dans la fenêtre des
boutons, appuyer sur
F5 pour basculer sur
le panneau "Shading",
sélectionner l'objet
"plan" et cliquer sur
"Add new" pour assi-
gner un nouveau
shader à votre objet.

Étape  07:

Dans le panneau "Material /
Ramps", activez "Shadeless"
pour rendre votre fumée visi-
ble, même s'il n'y a pas de
lumière dans votre scène.

Étape  08:

Cliquer sur le bouton "Ztransp"
pour activer la transparence
sans utiliser le raytracing et
régler la valeur de A (Alpha) à
0 pour utiliser le canal alpha
de la texture plutôt que l'alpha
"global".

Étape  09:

Appuyer sur la touche F6 pour
ouvrir le panneau des textures.

Step 10:

Cliquer sur un des boutons
vides et cliquer sur "Add new".

Step 11:

Régler le type de textu-
re sur "Clouds" et en-
trer la valeur 2 pour le
"NoiseSize", 6 pour le
"NoiseDepth" et renom-
mer votre texture en
"Couleur_Fumée".

Step 12:

Une fois encore, cliquer
sur un autre bouton
vide, cliquer sur "Add
new", choisir "Clouds"
pour le type de la tex-
ture et régler
"NoiseSize" à 1.3 et
NoiseDepth à 6. Renom-
mer cette texture en "Fumée_Alpha".
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Step 13:

Afficher l'éditeur UV/Image
pour peindre une nouvelle
texture et créez une nouvelle
image (Image >> New).

Step 14:

Régler "Width" (Largeur) et
"Height" (Hauteur) à 512, défi-
nissant ainsi la taille de la
nouvelle texture et cliquer sur
OK.

Step 15:

Cliquer sur le bouton "Enable
Painting
Texture"
dans le
header de
l'éditeur
UV/Image
pour acti-
ver le mo-
de "Paint"
et appuyer
sur les
touches N
et C pour
afficher les
fenêtres
"Image
Paint" et
"Image Properties".

Step 16:

Utiliser l'outil de peinture
pour créer une forme
aléatoire de couleur blan-
che, mais ne lui faites pas
toucher les bords de
l'image, ils doivent rester
entièrement noirs. Vous
pouvez aussi cliquer sur
le bouton "Airbrush" pour
peindre en continu.

Step 17:

Une fois que votre texture est terminée,
nommer la "Masque_Fumée" et cliquer
sur le bouton "Pack into blend". Blender
vous demandera si vous voulez packer
cette texture en fichier PNG... Cliquez
sur ce message.

Step 18:

Revenir au panneau d'édition des matériaux en appuyant
sur la touche F5.
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Étape 19:

Cliquer sur l'onglet "Texture",
cliquer sur "Couleur_Fumée"
et cliquer sur l'onglet "Map
Input".

Étape
20:

Cliquer
sur le
bouton
"UV",
cliquer
sur l'on-
glet
"Map to",
et activer
le bou-
ton
"Color".
Désacti-
ver les
autres boutons si nécessaire.

Étape  21:

Cliquer sur la couleur pourpre
et changer la en blanc.

Étape  22:

Revenir à l'on-
glet "Texture" et
sélectionner
"Fumée_Alpha".
Dans "Map
Input", activer
"UV", puis dans
"Map to", acti-
ver "Color" et
"Alpha"
(Attention : ne
pas activer le
bouton "Alpha"
deux fois, sinon
la transparence sera inversée).

Étape  23:

Cliquer sur la couleur pourpre et
changer la en noir.

Étape  24:

Revenir à l'on-
glet "Texture" et
sélectionner
"Masque_Fumé
e". Dans "Map
Input", activer
"UV" et dans
l'onglet "Map
to", activer seu-
lement "Alpha".
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Étape 25:

Changer la couleur pourpre
en noir et le mode "Mix" en
"Multiply".

B) Animer votre flux de particules :

Étape 01:

Sélectionner l'objet émetteur
(dans notre exemple : le
plan) et appuyer sur la tou-
che F7 plusieurs fois jusqu'à
ce que le panneau de réglage
des particules apparaisse.

Étape 02:

Cliquer sur
le bouton
"Add new"
pour créer
un nou-
veau flux,
nommé
"PSys" par
défaut.

Étape 03:

Dans les paramètres "Initial
Velocity", régler les vitesses
"Normal" et "Random" à 0.5.

Étape 04:

Dans "Global effects", régler les
paramètres d'accélération
"AccX" à 7, "AccZ" à 3 et
"Brown" à 15 (très utile pour
avoir un mouvement non li-
néaire).

Étape 05:

Vous devez maintenant créer
une nouvelle caméra, car nous
allons utiliser ce fameux type
de particules appelé "Billboard".

Étape 06:

Dans le panneau
"Visualization", choisir le type
de particules "Billboard". Un
billboard, ou "sprite" est un
simple carré qui fait toujours
face à la caméra (c'est pour-
quoi vous devez créer une ca-
méra à laquelle se référer).
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Étape 07:

Activer le bouton "Lock" pour
que tous les billboards res-
tent parallèles et éviter qu'ils
ne se croisent.

Étape  08:

Régler la valeur "Tilt" (Valeur
de rotation, qui semble être
exprimée en Radians) à 0.015
et régler la valeur de "Rand" à
0.4 pour donner à chaque
billboard un angle différent
lors de sa génération.

Étape  09:

Dans l'onglet "Particle Sys-
tem", régler les valeurs
"Amount" à 300, "End" à 200
et "Life" à 75... ou un peu
plus, jusqu'à ce que vos bill-
boards sortent du champ de
la caméra.

Étape  10:

Sauvegarder votre scène quel-
que part sur votre disque
dur. Je ne plaisante pas. C'est
très important!

Étape  11:

Cliquer sur l'onglet "Bake", juste
à côté de l'onglet "Particle Sys-
tem", et cliquer sur "Bake". Un
nouveau répertoire est créé à
côté du fichier .blend que vous
venez de sauvegarder (vous com-
prenez maintenant pourquoi
c'était si important ?). Ce réper-
toire est rempli d'un paquet de
fichiers (un par image) dans lesquels toutes les données con-
cernant les particules sont stockées.

Une fois que vos données sont "bakées" (ou, en d'autres ter-
mes, mises en cache), vous pouvez toujours éditer les paramè-
tres qui n'affectent pas le mouvement des particules (comme
leurs taille, couleur, transparence, enfants...)

C) Animer la déformation et la taille des billboards :
Étape  01:

Maintenant que votre flux de particule est mis en cache, sélec-
tionner l'objet émetteur (ici, le plan) et basculez dans l'éditeur
IPO.
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Étape 02:

Cliquer sur la combo box
"Show IPO type" et choisir
"Particles". Vous pouvez voir
les différents paramètres rela-
tifs aux particules sur la droite
de l'éditeur.

Étape 03:

Cliquer sur "BBTilt" (qui signi-
fie Billboard Tilt). Ce paramètre
est utilisé pour appliquer une
rotation sur un billboard en
fonction de la vue caméra et
de l'âge de la particule.

Étape 04:

Appuyer sur la touche CTRL, et
cliquer avec le bouton gauche de la souris aux alentours des
coordonnées 0.0/0.0. Cela aura pour effet d'ajouter un point
(utiliser le bouton droit de la souris si "Select with Left mouse
button" est activé dans votre menu Préférences).

Étape 05:

Une fois encore, créer un nouveau point aux environs de
l'image
200 avec
une va-
leur de
2.0.

Étape 06:

Ajuster les points de la tangente pour faire ressembler votre
courbe à une courbe logarithmique (NdT : Editer la courbe à
l'aide de la touche Tab pour faire apparaître ces tangentes).
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Étape 07:

Cliquer sur le
paramètre
"Size", à droi-
te de l'éditeur
IPO, et créer
un nouveau
point aux
coordonnées
0.0/0.0 com-
me vous
l'avez fait
pour le para-
mètre "BBTilt".

Étape 08:

Ajouter un
nouveau point
aux alentours
de l'image 200
avec une va-
leur de 20.
Garder le mo-
de d'interpola-
tion par
défaut. Main-
tenant, si
vous cliquez
sur "Play"
vous pouvez
voir vos bill-
boards grandir
et se défor-
mer tout au
long de l'ani-
mation.

Étape 09:

Appuyer sur F12 pour commencer le rendu et
voyez ce qu'il s'est passé. Oui, vous avez mainte-
nant une fumée épaisse et poudreuse !!!!
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D) Améliorez votre rendu avec le compositing :

Étape 01:

Ok, votre fumée semble
réaliste mais elle est un peu
plate et aurait besoin de
plus de détails et de con-
traste. Ouvrez donc l'éditeur
de Nodes et activer les bou-
tons "Composite Nodes" et
"Use Nodes".

Étape 02:

Si vous n'avez aucune cou-
che de rendu (Render
Layers) dans votre graphe,
ajoutez-en une nouvelle en
appuyant sur la barre d'Es-
pace >> Add >> Input >> Ren-
der Layers.

Étape 03:

Créer un
nouveau
noeud com-
posite en
faisant Es-
pace >> Add
>> Output >>
Composite
et un nou-
veau noeud
"Viewer"
avec Espa-
ce >> Add >>
Output >>
Viewer.

Étape 04:

Créer un noeud
"Displace" avec
Espace >> Add >>
Distort >> Dis-
place. Branchez
la sortie du
paramètre
"Image" du
noeud "Render
Layers" dans
les paramètres
"Image" et
"Vector" du
noeud
"Displace".

Étape 05:

Régler les
échelles "X
Scale" et "Y
Scale" du
noeud
"Displace" sur
20. Le noeud
Displace est
utilisé pour
donner un
mouvement
plus "fluide" à la fumée.

Étape 06:

Créer un noeud "Filter" avec
Espace >> Add >> Filter >>
Filter et régler son mode
sur "Kirsch".
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Étape 07:

Brancher la sortie
"Image" du
noeud "Render
Layers" à l'entrée
"Image" du
noeud "Kirsch".

Étape 08:

Régler le para-
mètre "Fac" de
"Kirsch" à 1.0 si
besoin. Kirsch
est utilisé pour
ajouter des dé-
tails qui seront
mixés avec le
rendu original.

Étape 09:

Créer un noeud
"Mix" avec Espa-
ce >> Add >> Color
>> Mix, et bran-
cher la sortie
"Image" du
noeud "Displace"
à la première
entrée "Image".

Étape 10:

Brancher la
sortie "Image"
du noeud
"Kirsch" dans
la seconde
entrée
"Image" du
noeud "Mix",
régler le para-
mètre "Fac" à
0.15 et activer
le bouton "A"
(Alpha).

Étape 11:

Créer un noeud "Blur"
avec Espace >> Add >> Fil-
ter >> Blur et ajuster les
valeurs de X et Y à 2. Ce
flou sert à "adoucir" la
fumée.

Étape 12:

Brancher la
sortie
"Image" du
noeud "Mix"
à l'entrée
"Image" du
noeud "Blur".
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Étape 13:

Ajouter un noeud
"Glare" avec Espace >>
Add >> Filter >> Glare.
Régler son mode sur
"Fog Glow" et brancher
la sortie du noeud
"Blur" à cette unique
entrée.

Étape 14:

Ajuster la valeur de "Mix" à 0.15, "Threshold" à 0.40 et "Size" à
9. Votre fumée est maintenant plus contrastée, ce qui lui don-
ne plus de densité.

Étape 15:

Pour finir, brancher la sortie du noeud "Glare" aux entrées des
noeuds "Composite" et "Viewer".

Étape 16:

Dans la fenêtre des boutons, appuyez sur la touche F10 pour
afficher les paramètres de rendu, et activer "Do composite".

Étape 17 :

Entrer le chemin vers lequel vous voulez sauvegarder vos ren-
dus et cliquer sur "Anim" pour rendre votre animation.

Conclusion
Avec les Billboards, vous pouvez créer beaucoup d'effets réalis-
tes et impressionnants. Un logiciel appelé "Particle Illusion"
(http://www.wondertouch.com) est un outil d'effets spéciaux
basé sur les sprites qui fonctionne exactement de la même
manière que les Billboards de Blender... mais en temps réel
(j'attends les développements créés par l'équipe du projet Apri-
cot, et plus particulièrement le support du GLSL dans la vue 3D
qui rendra possible la visualisation des billboards en temps
réel, avec les ombrages et les couches alpha).

Essayez cet outil incroyable...Cela vous donnera certainement
une idée de ce qu'il est possible de réaliser avec cette techni-
que. La prochaine étape est d'intégrer à Blender le même gen-
re de bibliothèques que celles disponibles avec "Particle
Illusion" pour créer ce type d'effet plus facilement, comme
dans une scène contenant plusieurs générateurs de particules
(fumée, chute d'eau ou feu), accessibles depuis n'importe quel
émetteur de la scène et importés avec File >> Append ou Link.

Fabriquez vos propres bibliothèques et partagez-les avec tout
le monde :

Tous les effets de particules peuvent être rassemblés sur un
même site web, comme www.blender-materials.org, et être
accessibles à tout le monde. Ensemble, nous pouvons le faire !
Alors jouez avec les billboards et les particules et amusez-vous!
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Introduction
Ce tutoriel vous aprendra à réaliser une fu-
mée éther animée avec Blender.

PARTIE I: les acteurs de l'animation

Etape 1: Tout d'abord ouvrez Blender, effacez
le Cube de
base et ajou-
tez un Grid.

Barre espace
> Add > Mesh
> Grid (32

x32) .

Retournez au mode Ob-
jet : Tab.

Ensuite avec votre Grid
sélectionné, basculez en
mode Weight Paint : Ctrl +
Tab. Et peignez votre Grid
afin de n'avoir qu'un
point orangé et le reste
en nuances de bleu au
jaune.

Servez-vous du panneau
Paint accessible depuis le
menu Edit (F9)

 Mix, Add et Multi > ajoute
de l’influence.

· Sub > permet d’en
soustraire.

· Blur > très utile, per-
met d’atténuer les
influences.

Etape 2: Ajoutons un objet déflecteur.

(Il modifie la direction d'un objet réactif : particules, soft
body etc.)

Placez un Empty : Add > Empty, juste en dessous dans le
coin ou le Grid avait le maximum d'influence (rouge).

Activez la Déflection, Physics Button (F7), et réglez-la avec:

· Wind : du vent avec un Strength (force) très faible :
entre 0,010 et 0,020

· Activez Use Max Dist et donnez une distance maximal
selon vos besoins. Cela atténuera l'influence du Wind,
en fonction de cette distance.
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Etape 3: Donnons de la souplesse à notre Grid.

Grâce à un réglage spécifique des Soft bodies, nous apporte-
rons l'illusion d'une matière souple et aérienne.

Sélectionnez le Grid, ouvrez le panneau Objet (F7), et le pan-
neau Physics.

Accédez ensuite à l'onglet Soft Body, et réglez-le comme suit :

·  Mass à 0 (ou, extrêmement faible).

·  Speed très faible (astuce : vous pouvez l'accélérer pour la
prévisualisation et le diminuer au rendu final),

·  Activez Use Goal > Group (pour prendre en compte votre
Weight paint).

·  Activez Use Edge et diminuez-le de moitié (les edges
pourront ainsi s'étirer selon les besoins de notre simula-
tion)

Maintenant, passons à l’a phase de tests.

Pour lancer un aperçu en OpenGL (dans notre fenêtre 3D)
placez-vous en vue caméra (touche 0 du pavé numérique).
Pressez Ctrl + A sur la fenêtre 3D.

Modifiez vos réglages de soft body et de déflection en consé-
quence.

PARTIE II : La matière Ethérique
Les paramètres de notre fumée, rendront l'illusion d'une fu-
mée assez réaliste avec un temps de rendu rapide.

·  Ajoutons une matière à notre Grid.

·  Panneau Shading (F5), puis panneau Material,
 Add New, et paramétrez en testant au fur et à mesure de
vos rendus (F12).

Dans l’onglet Mirror Transp, ajoutez de la Ray Transparency
avec:

· IOR à 1.0 (pas de déformation à l’incidence de la lumière)

· Un peu de Fresnel et jouez avec le Fact pour atténuer
l’influence

· Baissez le Gloss à 0 pour ne pas faire de calcul inutiles et
mettez le samples à 1.0

· Le Depth sera placé entre 5 et 10 (profondeur de transpa-
rence).
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· Dans l'onglet Material : baissez l'Alpha entre 0 et 0,25.

· Ouvrez l'onglet Ramps (sous l'onglet Material habituelle-
ment) et Activez l'option Show Col Ramp.

·Définissez un dégradé du blanc au noir avec une influence
selon la Normale des faces.

Une « nouvelle » fonction peut être utilisée ici.

· L'entrée Map input > Stress fait varier l'influence d'une
Texture en fonction des déformations du mesh.

· Donc, ajoutez une Texture Blend Panneau Texture (F6) Add
New > None / Blend (dégradé).

Retournez au panneau Material.

Ajoutez cette texture en Map input > Stress et en Map To > Col
et Alpha.

Vous êtes à présent prêt pour le rendu Final. Vous pouvez
activer le rendu de l'animation:

Dans le panneau Scene (F10), faites votre choix de sortie
(pour une vidéo c'est Avi ou Quick Time) et pressez le bouton
Anim pour lancer le calcul.

ATELIER 3D: Fumée Ether avec Blender

pa
r 

G
eo

rg
es

 M
ig

no
t

30

www.blenderart.org Numéro 16 | Mai 2008 - Wow Factor

Georges
Mignot

France

Site Web

http://www.melting3d.com/


Introduction
Dans ce tutoriel, vous verrez une méthode
simple de création de fourrure pour des
loups ou des animaux similaires, adaptée aux
images statiques.

Etape 1

Pour commencer, essayez de trouver des
images de références avec des vues de face,
de côté et de haut d'une tête de loup avec
une pose ressemblant à un gabarit
(Blueprint). Une façon de faire est d'utiliser la
"modélisation par boîte" (Box modelling) pour

créer la tête, avec un modificateur Mirror et un modifica-
teur "Subsurf" réglé à 1. Une fois que vous êtes satisfait
de votre modèle de base, vous pouvez appliquer le modi-
ficateur "Subsurf", après quoi vous pourrez apporter des
modifications plus précises à votre modèle.

Etape  2

Après avoir fait vos coutures, dépliez le mesh. Exportez la
couche UV dans un éditeur d'image (comme GIMP, Pho-
toshop, etc) puis dessinez sur cette couche dans diffé-

rents calques. Ce sera la peau de base de l'animal.
Comme la peau est sous la fourrure, vous n'avez pas be-
soin d'être précis.

Etape  3

Trouvez des images de fourrure en gros plan et ajustez-les
dans votre éditeur d'image avec les brosses, filtres, et
autres outils. Ces images définissent les couleurs domi-
nantes de la fourrure. Une fois encore, pas besoin d'être
précis, cette étape sert à définir les couleurs de base.

Etape  4

Séparez le nez, faites les yeux et dupliquez le mesh.

Etape  5

Divisez le mesh dupliqué en parties séparées aux endroits
où la fourrure change de couleur puis extrudez légère-
ment les bords de chaque surface de fourrure pour qu'ils
couvrent les surfaces avoisinantes. Cette manipulation
permettra de rendre les variations de couleurs entre les
zones de la fourrure plus naturelles.
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Etape 6

Ajoutez différentes textures de fourrure à chaque
parties, et modifiez les réglages des particules en
les accordant avec les couleurs naturelles de la
fourrure. Pour de meilleurs résultats, ajoutez des
variations sphériques et en vortex pour une four-
rure plus naturelle. Avec l'éditeur de noeuds
(Node Editor), vous pouvez appliquer un effet
"Profondeur de champ" (DOF) avec un effet Bo-
keh sur l'arrière-plan, et placer votre "animal de
compagnie" dans son environnement naturel.

Vous trouverez ci-dessous les réglages du systè-
me de particules utilisé pour le loup de ce tuto-
riel. Et sur la droite se trouvent la progression de
la séparation et de la modification du mesh pour
les particules.
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Introduction
Simuler un océan est un cas d'étude auquel
tout infographiste s'essayera un jour. Plu-
sieurs techniques sont à disposition, suivant
le type de logiciel que vous utilisez. L'utilisa-
tion des fluides est manifestement un des
meilleurs moyens pour créer ce genre d'effet,
mais c'est aussi celui qui prend le plus de
temps. Pour la scène de la bataille navale
dans "Pirate des Caraïbe III", des milliers d'or-
dinateurs ont travaillé pendant plusieurs se-
maines pour créer la simulation de l'eau pour
l'océan.

Une autre méthode est de simuler le mouvement de
l'océan en utilisant les techniques "normales", comme les
modificateurs et les keyframes. C'est ce que nous décri-
rons ici, en nous concentrant sur le mouvement des va-
gues et non sur le shading (deux des trois fichiers .blend
fournis contiennent des shading vraiment élémentaires).

Dernière chose avant que nous commencions : toutes les
valeurs sont uniquement données comme guide de base
et doivent-être ajustées, en fonction de la taille de votre
océan et de l'échelle de toute votre scène.

A) Préparation des trois textures élémentaires :
Étape 01:

Une fois notre cher Blender
lancé, créez une nouvelle
grille (Add >> Mesh >> Grid).
Mettez X Res et Y Res à 64
et appuyez sur OK. Si Blen-
der entre automatique-
ment en mode édition,
appuyez sur Tab pour re-
venir en mode objet.

Étape 02:

Appuyez sur ALT+R puis sur
ALT+G pour remettre à zéro
les valeurs de position et rota-
tion, la grille se déplacera au
centre de la scène. Appuyez
sur la touche N pour afficher
"Transform Properties", et
attribuez 6 à Scale X, Y, Z.
Appuyez sur F6 pour passer le
"Buttons Window" sur le pan-
neau "texture" et appuyez sur le bouton nommé "World"..

Étape 03:

Cliquez "Add New" pour créer
une nouvelle texture. Dans
"Texture Type", passez de
'None" à "Clouds" et réglez le
"NoiseSize" à 0.5, le
"NoiseDepth" à 6 et le "Noise
Basis" sur le type "Voronoi
F2". Pour retrouver plus facile-
ment cette texture par la sui-
te, changez son nom en
"Turbulence".

Étape 04:

Cliquez sur le bouton vide
juste en dessous de
"Trubulence", appuyez de
nouveau sur "Add New" et
choisissez le type "blend".
Cliquez sur l'onglet "color",
juste à coté de l'onglet
"Texture". Réglez le paramètre
"Bright" à 2.0 et "Contrast" à
0.01. Cliquez sur l'onglet "Texture" une fois de plus pour
nommé votre texture : "White".
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Étape 05:

Cliquez sur un autre bouton
vide, appuyez encore une fois
"Add new" et choisissez
"Clouds", réglez «NoiseSize» à
1.0 et "NoiseDepth" à 0. Nom-
mez cette texture "Bigwave".
Maintenant vous avez les
trois textures élémentaires
pour créer l'océan. Appuyer
sur la touche F9 pour passer sur le panneau "Editing" et sé-
lectionnez la grille.

B) Attention, prêt, partez !!
Étape 01:

Maintenant, il est
temps d'utiliser les
trois textures que
vous avez précédem-
ment préparées. Pour
cela, vous allez utili-
ser un des plus puis-
sants modificateurs
fourni par Blender, le
"Displace". Sélection-
nez votre grille, ap-
puyez sur le bouton
"Add modifier" et choisissez "Displace". Ce modificateur est
conçu pour déformer un mesh selon la luminosité de n'im-
porte quelle texture. Dans les paramètres de déplacement,
réglez le champ "Texture" sur "Turbulence", en référence à
l'une des textures que nous avons précédemment créée.

Étape 02:

Dans les paramètres de déplacement, réglez "Midlevel" à 0.35
et "Strength" à 0.125, diminuant ainsi l'influence de l'effet.

Pour animer ces creux et crêtes,
nous avons besoin d'utiliser un
objet pour indiquer au modifica-
teur de déplacement le décalage
entre la texture et la grille. Pour
faire cela, créez un nouveau Add
>> Empty puis appuyez sur ALT+G
et ALT+R pour le placer au centre
de la scène.

Étape 03:

Sélectionnez l'Empty et appuyez
sur la touche F9 pour passer
dans le panneau "Editing". Re-
nommé cet Empty
"Turbulence_1". Sélectionnez la
grille et examinez les paramètres
de déplacement dans le panneau
"Editing". Cliquez sur "Normal" et
passez sur "Z", cliquez alors sur "Local" et passez sur "Objet".

Étape 04:

Le mode "Object" est
utilisé pour ajouter
un décalage dans un
déplacement selon
la position d'un
autre objet. Dans le
champ "Ob:", tapez
"Turbulence_1" en
référence à l'Empty
que vous avez pré-
cédemment créé. Si
vous voulez voir
comment le déplace-
ment fonctionne, essayez de déplacer cet Empty.

ATELIER3D: Surf sur les vagues
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Étape 05:

Sélectionnez l'Empty et ap-
puyez sur la touche N pour
afficher la fenêtre flottante
"Transform Properties". Réglez
Scale X, Y et Z à 6.3. Réglez
LocX et LocY à 5 et LocZ à la
valeur 0. Sélectionnez la grille
et cliquez alors sur le bouton
"Set Smooth" dans le pan-
neau "Editing".

Étape 06:

Créez un autre Empty,
nommé le
"Turbulence_2" et
placez-le, comme
avant au centre de la
scène via les raccour-
cis Alt+R et Alt+G.
Réglez LocX, Y et Z à
-8.5 / 6 / 3 et les trois
Scale à la valeur 6.5.
Sélectionnez votre grille, revenez ensuite au panneau
"Editing" et appuyez sur le bouton "Copy" de "Displace" pour
dupliquer ce modificateur.

Étape 07:

Changez la valeur "Strength"
de ce déplacement dupliqué
à 0.25 et réglez le paramètre
"Ob:" à "Turbulence_2". Les
deux modificateurs "Displace"
peuvent être maintenant con-
trôlés indépendamment.

Créez un nouvel Empty et placez le à l'origine de la scène
(Alt+R et Alt+G). Nommé le "Waves", réglez LocX, Y et Z à 9 / 9
/ 2 et les trois Scale à la valeur 4.5.

Étape 08:

Sélectionnez la grille et comme
avant, appuyer sur le bouton
copy du modificateur "Displace"
en bas de la pile. Maintenant
vous avez trois déplacements
appliqués à la grille. Deux pour
ajouter des turbulences sur la
surface de l'océan et celui en bas de la pile pour créer de
plus grosses vagues. Remplissez le champ "Texture" avec
"Bigwave", en référence à l'autre texture précédemment
créée. Réglez la valeur de "Midlevel" à 0.5, "Strength" à 0.4 et
"Ob:" avec "Waves", en référence au dernier Empty créé.

Étape 09:

Une fois encore,
cliquez le bouton
"Copy" du modifica-
teur "Displace" en
bas de la pile. Pour
les paramètres de ce
quatrième
"Displace", cliquez
sur "Z" et mettez le
sur "Normal". Après,
cliquez sur "Object"
et mettez le sur
"Local". Réglez "Strenght" à 0.065 et remplissez le champ tex-
ture avec "White", sur la texture que vous avez précédem-
ment créée. Ce quatrième modificateur "Displace" est juste ici
pour pousser tous les vertices selon leurs propres normales
et pour générer les crêtes.

ATELIER3D: Surf sur les vagues
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C) Animer les vagues et
ajouter des objets flot-
tants :
Étape 01:

Allez à la première image de
l'animation, sélectionnez
l'Empty "Turbulence_1" et
appuyez sur la touche I pour
créer une nouvelle image clé
"Loc". Allez à l'image 200, déplacez l'Empty à -6 / -4 / 0 en
utilisant la fenêtre flottante "Transform Properties". Appuyez
de nouveau sur la touche I et choisissez "Loc", créant ainsi
une deuxième image clé.

Étape 02:

Animez l'Empty'
"Trubulence_2"
dans la direction
opposée en utili-
sant deux images
clé entre 0-> 200.
Les mouvements
des deux Empty
créent maintenant
un X, ajoutant
une turbulence
réaliste sur la
surface de la mer.
Maintenant, ani-
mez l'Empty nommé "Wave", plus lentement que les deux
autre, pour générer de plus grosses vagues. Selon la vitesse
des différents Empty, vous pouvez ajuster le mouvement des
vagues. Faites attention au type d'interpolation de 'Bezier"
par défaut de tout objet animé. Une interpolation linéaire
serait plus appropriée et peut être réglée dans l'éditeur de
courbe IPO en sélectionnant tous les points de contrôles et
en appuyant sur la touche T.

Étape 03:

Maintenant que nos avons notre
océan en mouvement, il est
temps de voir comment ajouter
un objet flottant dessus. Pour
cela, Blender fourni une fonction
vraiment facile à utiliser. Ajoutez
un nouveau cube à votre scène,
appuyer sur Alt+R pour remettre
à zéro la valeur de la rotation,
gardez le cube sélectionné et appuyez sur la touche SHIFT et
cliquez sur la gille pour l'ajouter à la sélection actuelle.

Étape 04:

Appuyez sur la touche Tab pour
basculer la grille en mode édi-
tion. Sélectionnez sur la grille,
trois vertices formant un triangle
équilatéral. Plus le triangle sera
grand, plus les turbulences qui
déplaceront le cube seront peti-
tes. Faites un choix selon le type
de mouvement que vous voulez
donner au cube.

Étape 05:

Garder tous les éléments sélec-
tionnés et appuyez sur les tou-
ches CTRL+P, confirmez alors
"Make Vertex Parent" lorsque
Blender vous le demandera. Ap-
puyer sur la touche Tab pour
sortir du mode édition. Mainte-
nant, vous allez certainement
devoir replacer manuellement le
cube sur la surface en utilisant la
touche G pour réduire la taille de la ligne pointillée à 0. Une
fois cela fait, appuyez sur play et amusez-vous !

ATELIER3D: Surf sur les vagues
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Optimisation pour des scènes plus vastes
Comme vous l'avez vu, ce type de technique est assez
simple à régler et donne des résultats convaincants. Le
modificateur Displace de Blender est l'un de mes préfé-
rés, parce que même pour un modèle avec des milliers
de polygones, c'est vraiment rapide (pour moi, c'est
probablement le plus rapide que j'ai vu parmi tous les
logiciels 3D que j'ai pu utiliser en 15 ans).

Encore une dernière astuce avant de nous quitter. Ici,
nous avons seulement simulé une petite portion d'un
océan. Si vous voulez créer une surface plus grande
avec un grand nombre de subdivisions sur la grille de
base, vous risquez de tuer votre ordinateur avant
d'avoir eu le temps d'appuyer sur le bouton play.

Mais, la subdivision peut être ajoutée/enlevée dynami-
quement pendant votre travail. Ajoutez seulement un
modificateur Subsurf sur le haut de la pile en mode
"Simple Subdiv". Alors, vous pourrez augmenter et di-
minuer le nombre de subdivisions quand vous vou-
drez. Augmentez simplement le nombre de subdiv
lorsque vous avez à ajuster le quatrième modificateur
Displace (le premier est celui qui génère les crêtes),
puis revenez à un nombre plus adéquate après l'avoir
augmenté. Vous pouvez même mettre deux niveaux de
subdiv différents, un pour la vue 3D et l'autre pour le rendu.

Si vous pouvez tester la dernière version SVN de Blender in-
cluant le patch "Adaptative Subdivision" (téléchargeable sur
graphicall.org) ; vous pouvez même réduire dynamiquement
le nombre de polygones selon la distance de la caméra.

Les parties éloignées de l'océan ne seront pas suffisamment
subdivisées pour reproduire de petites turbulences (mais
vous vous en fichez, parce qu'elles sont trop loin pour être
vues), mais ça fonctionnera encore sur le plus grand déplace-
ment "Big Waves" ... et le nombre de polygones gérés par
votre ordinateur sera spectaculairement réduit !!! Alors, vous
pourrez générer un océan infini sans un nombre énorme de
polygones. Amusez-vous, les enfants !

ATELIER3D: Surf sur les vagues
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Introduction
Créer un feu réaliste a été un des plus grands
défis de ma carrière d'artiste numérique. Pen-
dant des années, j'ai essayé différentes tech-
niques pour simuler ce genre d'effet. Après
avoir utilisé des objets animés simples avec
des shaders appropriés, des particules, des
sprites, des fluides, et même des Meta Balls
avec un compositing particulier (similaire à
celui utilisé dans Shrek), j'ai finalement at-
teint mon objectif qui était de créer le feu
animé parfait.

Pour commencer, je dois avouer que la tech-
nique original n'est pas de moi. La première

personne qui m'a initié à cette méthode a été le génial
Alan McKay, un des meilleurs artistes spécialisé dans les
effets de particules. L'année dernière, j'ai écrit un tutoriel
pour l'édition française de "Computer Arts" sur Ghost Rider
et comment imiter le même genre de feu en utilisant 3ds
Max et plus particulièrement les flux de particules. J'ai re-
gardé toutes les vidéos d'Alan, y compris celle qui explique
comment créer un feu en utilisant Pflow.

Le mouvement des flammes était assez réaliste, mais le
rendu semblait encore trop artificiel. J'ai pris mon rendu, je
l'ai importé dans After Effects et j'ai essayé de lui appliquer
toutes sortes d'effets de distorsion et de correction de cou-
leurs. A la fin, j'ai atteint mon but en créant le feu le plus
réaliste que j'avais jamais fait.

Quand j'ai fini mon tutoriel pour le magazine, j'ai découvert
la première version du patch de particules de Jakha sur
Graphicall.org. J'ai lu toutes les notes de versions et j'ai été
très impressionné par toutes les nouveautés apportées par
ce patch. Il apportait tout ce qu'il fallait pour créer ce mê-
me type d'effet dans Blender, vu qu'un outil de composi-
ting est inclus dans le logiciel avec tous les effets
nécessaires (comme Vector Blur et les Displace nodes).

Pour m'amuser, j'ai passé plusieurs nuits à créer à nou-
veau - en utilisant seulement Blender - tout ce que j'avais
fait avec 3ds Max et After Effects. C'est un des nombreux
exemples qui prouvent que Blender peut être utilisé pour
tous les types d'effets spéciaux, même les plus compli-
qués. Alors, prêts à brûler ? C'est parti !!!

A) Créer l'émetteur et les groupes de vertices:
Étape 01:

Premièrement, nous
avons besoin d'un objet
à brûler. Pour commen-
cer, ajoutez une nouvelle
primitive à votre scène,
comme Suzanne (le sin-
ge) pour l'instant.

Étape 02:

Basculez en mode d'Edi-
tion en appuyant sur la
touche TAB et désélec-
tionnez tous les vertices
en appuyant sur la tou-
che A.

Étape 03:

Appuyez sur la Barre
d'Espace de votre clavier
et choisissez Select >
Random.

ATELIER 3D: Brûler-les tous!
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Étape 04:

Entrez 40% pour la valeur aléa-
toire et cliquez sur OK. Plu-
sieurs vertices ont été
sélectionnés aléatoirement.

Étape 05:

Une fois que vos vertices ont
été sélectionnés, vous devez
créer un nouveau groupe de
vertices. Pour faire ceci, ap-
puyez sur [F9] pour afficher les
paramètres d'édition, et dans
le panneau "Links and Mate-
rials" cliquez sur le bouton
"New" pour créer un nouveau
groupe de vertices. Nommez-le
"Emivert" et cliquez sur
"Assign", juste en-dessous du
bouton "New".

Étape 06:

Appuyez sur la touche TAB
pour sortir du mode d'édition,
sélectionnez Suzanne, et ap-
puyez sur [Shift+O] pour lui
ajouter un modificateur Sub-
surf.

Étape 07:

Gardez votre Suzanne sélec-
tionnée et appuyez sur [F7]
plusieurs fois jusqu'à ce que le
panneau de réglage des parti-
cules apparaisse dans la fenê-
tre des boutons. Cliquez sur
"Add new" pour ajouter un

nouveau système de
particules (appelé
"Psys") à votre objet.

Étape 08:

Maintenant, vous devez
sauvegarder votre scène
quelque part sur votre
disque dur, car Blender
va créer un nouveau
répertoire à côté de
votre fichier .blend dans
lequel les données du
système de particule
seront mises en cache.

Étape 09:

Gardez Suzanne sélectionnée et allez dans le
panneau "Physics". Réglez les paramètres
"Random" à 0.5, "AccZ" à 8.0 et "Brown" à 5.0.
Maintenant, les particules s'élèvent et certai-
nes sont agitées aléatoirement selon la valeur
du paramètre "Brown".

Étape 10:

Dans le panneau "Particle System", fixez la
valeur de "Amount" à 3500, "End" à 150 et
"Life" à 25. Dans "Emit From", activez
"Random" et "Even" et changez "Jittered" en
"Random".

Étape 11:

Dans le panneau "Extras", cliquez sur la com-
bo-box "Neg" dans la section "Vertex group"
et sélectionnez le groupe "Emivert" que vous
avez créé précédemment. Maintenant, les
particules sont seulement émises depuis les
vertices de ce groupe de vertices.

ATELIER 3D: Brûler-les tous!
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Étape 12:

Cliquez sur l'onglet
"Bake", situé à côté de
l'onglet "Particle System".
Entrez une valeur de 150
pour "End" et cliquez sur
"Bake". Blender va créer
un nouveau répertoire,
juste à côté du fichier
".blend" sauvegardé pré-
cédemment et va le remplir avec de nombreux fichiers (un
pour chaque image de l'animation). Toutes les données mi-
ses en cache seront sauvegardées ici.

B) Générer un paquet de sphères:

Étape 01:

Créez une nouvelle Icos-
phère avec une subdivi-
sion de 3, puis appuyez
sur la touche Tab pour
sortir du mode d'édition
et appuyez sur [ALT+R],
puis [ALT+G] pour réinitia-
liser sa position et sa
rotation. Placez cette Icos-
phère aux coordonnées
du centre de votre scène.

Étape 02:

Animez la taille de l'Icos-
phère au fil du temps.
Créez la première keyfra-
me (image clé) à l'image
1 et réduisez l'échelle à

environ 0 sur les axes X, Y, et Z. A l'image 10, créez une nou-
velle keyframe et donnez une valeur de 0.2 aux trois échelles.
Terminez en créant la dernière keyframe à 30 et redéfinissez
les valeurs d'échelle à 0. Modifiez la courbe tangente (dans
l'éditeur IPO Curve) de façon à créer une sorte de parabole.

Étape 03:

Sélectionnez l'Icos-
phère et ajoutez-lui
un nouveau shader.
Dans le panneau
"Material" (à l'aide
des échantillons de
couleurs), réglez la
valeur de "Col"
(couleur) sur un
code hexadécimal
de D77503, et la
valeur de "Spe"
(spéculaire) sur
F7F69B. Réglez la
valeur de "A"
(alpha) sur 0.2 et
cliquez sur le bou-
ton "Ztransp" (dans
le panneau Links and Pipeline) pour activer la transparence
sans utiliser le Raytracing.

Étape 04:

Dans le panneau "Shaders", ajustez les
valeurs de "Spec" à 2.0 et "Hard" à 200.
N'activez pas le Raytracing (Ni "Ray Mir-
ror", ni "Ray Transp"), car les temps de
rendu pourraient être vraiment longs et
les valeurs de "Depth" (Profondeur) ne
seront jamais assez hautes pour obtenir
un bon résultat.

ATELIER 3D: Brûler-les tous!
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Étape 05:

Sélectionnez votre émet-
teur de particules
(suzanne) et dans les
paramètres des particu-
les, rendez-vous dans le
panneau "Visualization".
Cliquez sur "Point" et
changez-le en "Object".
Entrez "Sphere" dans le
champ "OB", en référence à l'Icosphère animée. Cliquez sur
"Emitter", pour calculer le rendu de Suzanne en plus des par-
ticules.

Étape 06:

Sélectionnez Suzanne et
ajoutez-lui un nouveau
shader, donnez-lui une
couleur diffuse noire et
activez le bouton
"Shadeless". Ceci vous
aidera à visualiser la for-
me de l'émetteur alors
que les flammes sortiront
de celui-ci.

Étape 07:

Appuyez sur [F6]
plusieurs fois
pour afficher les
boutons de Textu-
re, cliquez sur
"World", puis "Add
New", et choisis-
sez un "Texture
Type" de type
"Clouds". Laissez
tous les paramè-

tres avec leurs réglages par défaut et nommez cette nouvelle
texture "Turbulence".

Étape 08:

Ajoutez un nouvel Empty à la
scène (Barre d'espace > Add >
Empty), sélectionnez-le et ap-
puyer sur [F7] plusieurs fois
pour afficher les boutons
"Physics". Dans l'onglet
"Fields", choisissez "Texture"
dans la combo-box et entrez
"Turbulence" dans le champ
"Texture". Changez "RGB"
en "Gradient" et réglez
"Strength" à 1.0.

Étape 09:

Sélectionnez Suzanne, ap-
puyez sur [CTRL+B] et choi-
sissez "Free bake
selected". Faites encore
[CTRL+B] et "Bake selected"
pour supprimer et créer le
cache à nouveau (car nous
venons d'ajouter un nou-
veau champ "Texture").

Étape 10:

Ajoutez une caméra et une
lampe à votre scène, réglez
l'énergie de la lampe à , et
bougez-la vers l'avant de la
zone en haut à droite de
votre système de particu-
les, entre les particules et
la caméra.

ATELIER 3D: Brûler-les tous!
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Étape 11:

Ajoutez un nouveau
Lattice à votre scène,
et réglez ses valeurs
"U" et "V" à 2, et la
valeur "W" à 5.

Étape 12:

Appuyez sur la touche
Tab pour activer le
mode d'édition et sé-
lectionnez tous les
points de contrôle du
Lattice en appuyant
sur la touche [A]. Créez
un nouveau groupe de
vertices que vous
nommerez
"Lattice_Points" et assi-
gnez-lui tous les points
sélectionnés.

Étape 13:

Sortez du mode d'édition,
sélectionnez Suzanne et
ajoutez-lui un nouveau
modificateur "Lattice".
Entrez le nom de votre
lattice dans le champ "OB"
et saisissez
"Lattice_Points" dans le
champ "Vgroup", pour
déformer seulement les
particules et non le mesh
émetteur.

Étape 14:

Sélectionnez le lattice, basculez
en mode d'édition et bougez
les points du haut pour réduire
et entortiller le haut des flam-
mes. Une fois que c'est fait,
quittez le mode d'édition et
contrôlez votre animation en
appuyant sur [Alt+A].

C) Le rendu et le compositing:
Étape 01:

Maintenant que le mouvement
de votre flamme est paramétré,
nous devons ajoutez la touche
finale magique à notre rendu à
l'aide des outils de composition.
Appuyez sur [F10] pour afficher
les paramètres de rendu. Cli-
quez sur l'onglet "Render
Layers" et activez le bouton
"Vec".

Étape 02:

Ouvrez une fenêtre
"Node Editor" et sélec-
tionnez "Composite No-
des" et "Use nodes". Il
devrait maintenant y
avoir un noeud "Render
Layers" et un noeud
"Composite". Si ce n'est
pas le cas, ajoutez-les
en faisant Add > Input >
Render Layers et Add > Output > Composite.

ATELIER 3D: Brûler-les tous!
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Étape 03:

Maintenant, faites Add >
Filter > Vector Blur pour le
prochain noeud, et con-
nectez les sorties "Image",
"Z" et "Speed" du noeud
"Render Layer" au mêmes
entrées du noeud "Vector
Blur". Activez le bouton
"Do Composite" dans l'on-
glet "Anim" de la fenêtre de boutons "Scene", et lancez un
rendu en appuyant sur [F12] pour voir le composite courant.
Avec seulement ces réglages, nous avons transformé un pa-
quet de sphères en un flamme convenable.

Étape 04:

Continuez en fai-
sant Add > Distort >
Scale et reliez la
sortie "Image" du
noeud "Vector Blur"
à la même entrée
du noeud "Scale",
puis réglez les va-
leurs "X" et "Y" à
1.05.

Étape 05:

Ajoutez un noeud
Vector > Map Value,
réglez la valeur
"Offs" à -0.50 et
reliez la sortie
"Image" du noeud

"Scale" à l'entrée "Value" du noeud "Map Value".

Étape 06:

Ajoutez un noeud Distort > Dis-
place et réglez les valeurs "X
Scale" et "Y Scale" à -10. Reliez la
sortie du noeud "Map Value" à
l'entrée "Vector" du noeud
"Displace", puis la sortie "Image"
du noeud "Vector Blur" à l'entrée
"Image" du noeud "Displace".

Étape 07:

Ajoutez un noeud Convertor >
ColorRamp et bougez le curseur
noir vers la droite, à environ 60%
du dégradé. Reliez la sortie du
noeud "Displace" à l'entrée "Fac"
du noeud "ColorRamp".

Étape 08:

Ajoutez un noeud Color > Mix et
changez le mode "Mix" en "Add".
Réglez la valeur "Fac" à 1.0, et
reliez la sortie du noeud
"Displace" à la première entrée
"Image" du noeud "Add" et la
sortie du noeud "ColorRamp" à
la seconde entrée "Image".

ATELIER 3D: Brûler-les tous!
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Étape 09:

Dupliquez le noeud "Add" en appuyant sur [Shift+D] et réglez
le paramètre "Fac" du noeud dupliqué sur 2.0. Ajoutez un
noeud Filter > Blur, changez son mode "Flat" en "Gauss", puis
réglez les valeurs "X" et "Y" à 20. Reliez la sortie "Image" du
noeud "ColorRamp" à l'entrée "Image" du noeud "Blur". Reliez
la sortie du
noeud "Blur" à
la seconde
entrée "Image"
de notre
noeud "Add"
dupliqué. Pour
finir, reliez la
sortie du
noeud "Add"
original à la
première en-
trée "Image"
du noeud
"Add" dupli-
qué.

Étape 10:

Ajoutez un
noeud Color >
RGB Curves, et
reliez la sortie
du noeud
"Add" à l'en-
trée "Image"
du noeud "RGB
Curves". Ajou-
tez deux
points à la
courbe "C" et
changez son
profil pour qu'elle ressemble à une courbe exponentielle.

Étape 11:

Ajoutez un autre noeud
Filter > Blur, et changez son
mode "Flat" en "Gauss", et
réglez les valeurs "X" et "Y"
à 40. Ajoutez un nouveau
noeud Color > Mix, réglez
son mode sur "Add" et sa
valeur "Fac" à 1.0. Reliez la
sortie du noeud "RGB Cur-
ves" à l'entrée "Image" du
nouveau noeud "Blur" et à
la première entrée "Image"
du nouveau noeud "Add". Pour finir, reliez la sortie du noeud
"Blur" à la seconde entrée
"Image" du noeud "Add".

Étape 12:

Enfin, ajoutez un noeud
Output > Viewer et connec-
tez la sortie du dernier
noeud "Add" aux entrées
"Image" du noeud "Viewer"
que nous venons de créer,
et du noeud "Composite"
original.

Étape 13:

Dans la fenêtre des boutons, appuyez sur
[F10] pour revenir aux paramètres de ren-
du. Réglez les options de rendu désirées
(Format du fichier, compression, sauvegar-
de) pour votre vidéo. Lancer un rendu de
toutes les images de votre animation en
cliquant sur le bouton "Anim" ou en ap-
puyant sur [Ctrl+F12].

ATELIER 3D: Brûler-les tous!
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Il n'y a pas de fumée sans feu:
A l'aide du nouveau système de particules de Blender 2.46 (et
plus particulièrement la fonction "Reactor", qui peut générer
un système de particules à la mort d'un autre), vous pouvez
combiner ce tutoriel de feu avec un autre qui explique com-
ment créer de la fumée réaliste.

Dans un futur proche, Blender réintégrera une fonction mer-
veilleuse (précédemment intégrée, puis rendu obsolète au
cours de la production du projet Peach) qui rend possible
l'édition de tous types de particules, et pas seulement les
poils ou la fourrure. Avec cette fonction, vous pouvez sculpter
la forme de votre feu sans utiliser de lattice, comme nous
l'avons fait ici.

Le futur du système de particules est très prometteur, et
Blender n'a pas à avoir honte de ses possibilités, comparé à
d'autres logiciels.

ATELIER 3D: Brûler-les tous!
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Introduction
Cette scène nécessite de calculer le
mouvement très spécifique de milliers
d'objets, l'idée de base étant de cons-
truire le kiosque en faisant tomber du
ciel de petits objets.

Animer tous ces objets manuellement
n'étant clairement pas la meilleure ni
la plus adaptée des idées, nous allons
écrire un script en python qui pourra
traiter le mouvement de chaque objet
à partir de sa position finale.

Les opérations de base
Mon approche consiste en deux algorithmes simples et
prévisibles, un qui contrôle la chute (axe Z) et un qui
contrôle la translation (axes X et Y) de l'objet.

Pour le mouvement Z, j'ai utilisé la formule de la chute
libre que nous avons tous appris à l'école : (Wikipedia et
Google sont de très bons outils pour ceux qui ont une
mémoire défaillante ou qui sont nuls en maths, comme
moi)

z = (- 0.5 * Gravité * Temps ** 2) + (Vitesse Initiale *
Temps) + Altitude Initiale

Vous pouvez retrouver cette fonction appropriée à la ligne
87 du script. Utiliser une formule de chute libre m'a don-
né des valeurs de Z cohérentes et réalistes avec lesquel-
les commencer. Pour la partie translation, une simple
extrapolation linéaire a été utilisée. Elle fonctionne com-
me ceci :

a = 2
b = 10
Premièrement, trouvez l'écart entre a et b à l'aide d'une
soustraction

b - a = 8

Puis divisez cet écart avec une valeur assez grande, di-
sons 100

8 / 100 = 0.08

Cela nous donne 100 intervalles espacées régulièrement
entre a et b. Par exemple, si nous voulons trouver la posi-
tion médiane, nous ferons

0.08 * 50 = 4

Ce qui nous permet de compenser la valeur de a

4 + a = 6

La même opération peut être appliquée à n'importe quel-
le valeur comprise entre 0 et 100:

(b - a) / 100 * 85 + a = 8.8

Ce qui est sympa avec ces opérations, c'est que nous
pouvons utiliser des valeurs plus grandes que 100 pour
extrapoler. Prenons une valeur de 175 par exemple:

(b - a) / 100 * 175 + a = 16

Dans le script, j'utilise ces opérations pour obtenir les
coordonnées en X et en Y de chaque objet à l'aide de leur
positions finales (b) et des coordonnées du centre du
kiosque (a) que j'obtiens à l'aide d'un objet "Empty" que
je peux toujours animer avec des mouvements oscillatoi-
res pour créer des effets intéressants. Jetez un oeil au
lignes 68 et 78 pour la mise en oeuvre finale.

MAKING OF: ‘Réalisation d'une scène à l'aide de procédures’
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Ajouter des variations:
Python intègre un module appelé 'random' qui est génial pour
ajouter des variations aux résultats de chaque exécution des
formules mathématiques. Ce n'est pas encore aléatoire, mais
pseudo-aléatoire, ce qui veut dire que le code utilise un nom-
bre "graine" que vous pouvez spécifier. Il génèrera ainsi plu-
sieurs nombres à partir de cette graine. Et si, plus tard, vous
spécifiez le même nombre "graine" et que vous demandez les
mêmes choses, il génèrera exactement les mêmes nombres.
Cette caractéristique est géniale car elle nous permet de pré-
voir entièrement le déroulement du programme comme je l'ai
mentionné précédemment.

Si vous revenez aux fonctions "Loc" et "Rot", vous verrez com-
ment les nombres générés aléatoirement sont utilisés pour
donner des variations aux résultats. La ligne 39 montre com-
ment définir une graine aléatoire différente pour chaque objet
qui restera le même dans le temps, évitant ainsi un décalage
temporel dans le mouvement des objets.

Faire fonctionner le tout
Avant d'exécuter le script principal, j'ai sauvegardé toutes les
positions des objets dans les propriétés du bon vieux Game
Engine en utilisant ce script à usage unique. J'ai aussi sauve-
gardé un décalage temporel de départ pour chaque objet.
L'exemple que je partage ici a été utilisé pour le toit. Le mo-
ment du départ est défini en fonction d'une formule qui calcule
la distance séparant l'objet du centre comme vous pouvez le
voir à la ligne 38 et c'est pourquoi les tuiles du toit commen-
cent à tomber à partir de l'extérieur vers le centre. J'utilise ici
aussi quelques générateurs aléatoires.

Ce script utilise beaucoup de nombres aléatoires et différentes
équations et nous devons toujours contrôler la position finale
de chaque objet pour que l'ensemble construise correctement
le kiosque. C'est ici que les équations prévisibles et les généra-
teurs pseudo-aléatoires vont nous sauver.

L'astuce est de prévoir où l'objet va se situer à la fin de son
mouvement et d'appliquer un décalage à son mouvement en

conséquence, de telle sorte que lorsqu'il atteint sa position fina-
le, il se trouve exactement où vous l'avez décidé. Aux lignes
96-98 et 113-115, j'appelle les fonctions de placement et de rota-
tion mais je leur donne une valeur de temps de 100 qui marque
la fin du mouvement (comme si on voyait dans le futur !). Puis,
aux lignes 130-135, je soustrais simplement cette valeur aux
résultats des équations temps-réel et j'ai tous mes objets qui
atterrissent comme par magie au centre de la scène. Pour finir,
j'ajoute les valeurs de position précédemment sauvegardées
dans chaque objet avec le second script et maintenant, ils tom-
bent à la position escomptée!

Lisser les mouvements:
Pour le moment, les équations utilisées, en particulier celle qui
extrapole les translations, retournent un déplacement linéaire
qui produisent un mouvement très mécanique. Cependant, il
est plus agréable d'avoir un effet de ralentissement ou de décé-
lération juste avant que chaque objet atteigne sa position fina-
le. C'est ce que les courbes IPO font de mieux, j'en ai donc
utilisé une pour contrôler les valeurs de temps de chaque équa-
tion. Regardez à la ligne 52 pour la fonction qui récupère la
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valeur courante d'une courbe nommée simplement "IPO", et si
vous contrôlez les résultats de chaque fonction de rotation ou
de mouvement, vous verrez comment cette valeur est utilisée
pour redéfinir les valeurs de temps qui, sans elle, resteraient
linéaires.

Maintenant que vous avez compris comment cela fonctionne,
vous pouvez essayer vous-même avec ces instructions :

· 1- Ajoutez les propriétés du Game Engine aux objets, en
stockant leurs positions finales ainsi qu'un décalage tem-
porel de départ. Ceci est géré par le second script qui
fonctionne sur les objets sélectionnés. La propriété "Start"
est alors définie par différentes formules que vous pouvez
écrire pour gérer n'importe quel cas de figure.

· 2- Rassemblez vos objets dans un groupe que vous nom-
merez "Main". Lorsque vous le souhaitez, il vous suffira de
désactiver leur animation simplement en les retirant de ce
groupe.

· 3- Transformez le script principal en "ScriptLink" qui se
déclenchera à chaque changement de frame et faites le
ménage dans vos frames!

· 4- Vous aurez besoin d'une courbe IPO "Temps" associée à
un objet "Empty" appelé simplement "IPO" qui va de (0, 0)
à (100, 10). Elle contrôle l'interpolation de chaque objet
pour ajouter des effets de ralenti, etc

· 5- Vous aurez besoin d'un autre objet "Empty" nommé
"Center" situé au centre de la scène ou au centre de l'effet
de construction. Vous pouvez animer cet objet pour créer
de jolis mouvements d'oscillation.

· 6- Lancez l'animation en appuyant sur [Alt+A] ou en utili-
sant la "Timeline"

Crédits:
Wow Factor produit par martestudio.com

Rendu par Oliver 'imshadi' Zúñiga

Remerciements particuliers à Joshua 'aligorith' Leung et Geof-
frey 'briggs' Bantle pour avoir développé les outils nécessaires
à la création de cette animation.

contact@zanqdo.com

Vous pouvez regarder l'animation finale ici:

http://www.vimeo.com/5049795
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Introduction
Lorsque Sandra Gilbert m'a contacté en
avril dernier pour écrire un article pour
le BlenderArt magazine au sujet de
mon court-métrage "Tape-à-l'œil», mes
premières réactions ont été à la fois le
bonheur et la surprise. J'ai immédiate-
ment accepté en pensant que ce serait
génial de revenir sur mon travail et
donner un aperçu sur la production de
celui-ci. Après réflexion, il est apparu
évident que je n'ai pas utilisé beau-
coup d'effets spéciaux, ou éléments
cachés dans Blender.

Mon court métrage a été minimaliste sur de nombreux
points, y compris dans les outils que j'ai utilisé pour le
créer. J'y ai pensé un peu plus, et cela m'a donné une
idée pour l'article. Pourquoi devrais-je faire un article sur
les outils et les astuces que j'ai utilisés, qui sont proba-
blement déjà expliqué dans au moins une douzaine
d'autres tutoriels, tandis qu'à la place, je pourrais écrire
un article sur l'expérience que j'ai acquise grâce à ce pro-
jet. Une chose certaine que j'ai appris, c'est que les con-
traintes stimulent l'imagination. Dans cet article, je vais
essayer de fouiller dans ma production, et la façon dont
j'ai travaillé pour terminer le travail à temps.

Tout d'abord, vous devriez regarder le film si vous ne
l'avez pas déjà fait. Il peut être consulté sur notre site
Web. Si vous vous demandez "n'est-ce pas que le site de
Jonathan Williamson, alias Mr_bomb sur Blenderartists.org
?", assurez-vous de lire le blog pour tout comprendre.
Pour les autres, lisez le aussi ! Une fois sur le site, allez
simplement dans la galerie, puis dans la section anima-
tion.

Maintenant que vous l'avez regardé, je vais vous expli-
quer dans quel contexte le film a été créé. Le court mé-
trage a été créé comme un projet de thèse pour mes 2
ans d'études de cinéma à l'université. Le sujet qui nous
est donné était: «Le cinéma et moi-même", et oui, j'ai été
le seul à venir avec un film d'animation.

Et c'est exactement la source de mon problème principal.
Il n'y avait que trois règles à suivre: le film devait se si-
tuer entre 3 et 5 minutes, tourner le film dans un maxi-
mum de deux jours, et utiliser uniquement les salles de
montage au maximum 25 heures. Heureusement pour
moi, mon professeur m'a exempté des deux derniers.

Cela m'a laissé deux mois entiers de Février à Mars et 8
jours en Avril pour modéliser, texturer, animer, faire les
rendus, composer la musique, et éditer le tout. Et pour
compliquer le tout, j'ai reçu un appel le 1er Février d'une
équipe de recherche qui m'a demandé de créer une ani-
mation de deux minutes.

Pour faire court, j'ai accepté, et il m'a fallu un mois pour
la terminer. J'ai officiellement commencé à travailler sur
mon court-métrage le 3 Mars. Maintenant, vous vous de-
mandez probablement pourquoi je vous explique tout ça.
Permettez-moi de répondre que ces histoires ont fait de
mon film ce qu'il est. Pendant cette période, mon court-
métrage est devenu l'essentiel de ma vie. Donc, mainte-
nant, mon principal problème doit être clair: Comment
faire pour créer 5 minutes d'animation dans une si courte
période de temps.

La première chose que j'ai fait était d'écrire mon scénario.
J'ai retiré quelques plans qui n'étaient là que parce qu'ils
étaient cools, ce qui m'a amené à affiner mes intentions,
et par la suite m'a fait changer le titre pour "Tape-à-l'oeil".
Puis j'ai commencé à diviser mon scénario en particulier
par des «scènes» et des sections.

MAKING OF: ‘A la rencontre de l’oeil alias Projet Lightbulb’
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Puisque je ne suis vraiment pas doué pour le dessin, et que je
n'avais pas beaucoup de temps à perdre, je n'ai pas fait de
story-board, [mais vous devez en faire un si vous projetez de
faire un court-métrage], mais je m'étais assez familiarisé avec
mon scénario pour savoir exactement comment j'allais faire
pour représenter chaque séquence. J'ai commencé par créer
une série de dossiers représentant chaque scène. Voir image 1
pour voir mon arborescence.

Mon dossier de "pré-prod" était rempli de mes scénarios, mais
aussi avec des éléments d'inspiration. Je garde toujours une
source d'inspiration et le dossier de référence en cas de doute
sur le sentiment que je veux donner à un plan. Que ce soit
des chansons, des images ou des textes, j'ai gardé tout ce qui
m'a inspiré pour ce film. Dans mon dossier "Prod", j'ai gardé
tous les fichiers que j'ai créé pendant la production.

D'abord, j'ai créé un dossier pour les modèles et les textures.
Tous les modèles que j'ai utilisé d'une scène à l'autre, une
ampoule électrique et un personnage étaient conservés dans
ce dossier afin que je puisse les ajouter à tout moment et les
relier aux scènes. Les textures ont été minimes, sinon inexis-
tantes dans ce film, et donc une partie du dossier est restée
quasiment vide. J'ai ensuite créé deux dossiers principaux
pour la production.

Je voulais faire comme ça pour plusieurs raisons. Tout d'abord,
mon court-métrage est sur la dualité entre le côté technique
d'une production qui comporte des éléments qui sont loin
d'être "artistiques", et les émotions et la créativité qui se dé-
gagent de ces contraintes techniques. Je voulais que ma pro-

duction tienne compte de cela, et je voulais travailler sur mon
projet comme si les deux parties distinctes de mon film
étaient deux projets séparés qui ont été mélangés ensemble.
J'ai aussi fait cela pour avoir une idée de l'importance de la
partie "émotion" puisqu'elle devait être terminée au moins
deux semaines avant la fin de la production pour laisser du
temps à mon compositeur (Derek McTavish Mounce) de créer
un chef-d'oeuvre musicale, ce qu'il a d'ailleurs fait (merci De-
rek!).

Pour les délais, j'ai créé un petit calendrier pour que je puisse
comparer ma progression réelle à celle prévue. Voir Image 2
pour voir comment j'ai organisé mon temps. Comme je me
trompais ... J'ai fini par la partie émotion vers le 28 Mars, et
l'ai vite envoyé à Derek, puis j'ai travaillé sur la partie techni-
que pendant deux petits jours intenses pour terminer en lan-
çant les rendus à partir du 4 avril grâce à mon nouveau
processeur Quadcore.

Derek a travaillé encore plus intensément et a fini par me
donner la chanson à 3h du matin le dimanche 6 avril. J'ai en-
suite été à l'école, où j'ai fais le montage final, avec tous mes
fichiers de rendus et la fabuleuse musique de Derek. La ver-
sion finale été terminée lundi après-midi, plus de 24 heures
avant la date limite. Voilà comment s'est déroulé de manière
globale mon projet. Maintenant, nous allons passons au CGI.

MAKING OF: ‘A la rencontre de l’oeil alias Projet Lightbulb’
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Une chose que je savais depuis le début, était que le rendu,
même sur mon Quadcore, prendrait beaucoup de temps. Donc
j'ai décidé d'être minimaliste. Je n'ai pas du tout utilisé de
textures, sauf un peu de procédurales pour les parties métalli-
ques de l'ampoule. Vous trouverez à la fin de l'article le lien
pour télécharger le .blend de l'ampoule et l'image 3 pour voir
ma configuration matérielle.

La texture «métal brossé" a ensuite été appliquée avec l'op-
tion "nor" pour créer une surface bosselée sur l'objet. L'utilisa-
tion de textures procédurales et de matériaux très simples
améliorent beaucoup le temps de rendu lors de la production,
ce qui m'a permis de terminer à temps. Je suis allé dans le
même sens avec la modélisation et l'éclairage. Je n'ai gardé
que le strict minimum du plan afin qu'il paraisse bien [ou soit
au moins décent]. Voici un exemple de l'éclairage «le plus
complexe» que j'avais dans le film. C'est pendant la séquence
de transition entre la première et la deuxième partie, lorsque
l'ampoule est inséré dans une sorte de projecteur, d'où le
personnage émerge.

Comme cette scène particulière devait entrer en conflit avec
ce qui précédait, les scènes de base plus techniques, j'ai eu
besoin de pousser l'émotion de la lampe. C'est pourquoi j'ai
utilisé des lumières vives colorées, rouge et bleu, ainsi les
couleurs peuvent se combattre comme la technique et la créa-
tivité s'opposent elles-mêmes dans mon court-métrage. Com-
me l'Occlusion Ambiante pour l'illumination globale était ici
hors de question à utiliser en raison du temps de rendu de-
mandé, j'ai joué avec différents éclairage pour la simuler, et

j'ai finalement utilisé une seule lampe (ce qui n'est pas vrai-
ment une astuce...) pour adoucir les ombres des deux autres
puissantes lampes. Notez la façon dont les deux lampes de
couleur sont très faibles au niveau du sol. Cela a été spécifi-
quement fait pour créer de longues ombres qui se confondent
avec les ombres créées par les autres lampes. Ce type d'éclai-
rage faible angle ajoute vraiment une émotion et un sens dra-
matique à une scène, comme un lever ou un coucher de soleil
peut le faire. Voir l'image 5 pour le rendu de la scène. Quant
aux petites lumières dans le trou et le long du filament de
l'ampoules, j'ai simplement utilisé un matériau blanc sans
ombre sur l'objet, puis ajouté une lampe sphérique «sans
ombre» au-dessus.
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Une autre scène qui a été assez importante a été la scène
avec le "champ d'ampoule", dans laquelle le personnage vole
au milieu d'environ trois mille ampoules, puis les met en cer-
cle (images 6 et 7). Pour générer le champ, j'ai utilisé le géné-
rateur Cloud d'Alan Dennis. Je l'ai simplement utilisé pour
générer des sommets placés aléatoirement sur une zone as-
sez importante. J'ai ensuite ajouté mon modèle ampoule, dé-
pouillé de ses détails majeurs (filament dans l'ampoule,
modificateur subsurf, réfraction et la réflexion du matériau,
etc.) et j'ai fait un duplivert (Object menu (F7)), sur mon nua-
ge de points. Puis vient la partie amusante des nodes.

Pour allumer ces ampoules, j'ai simplement dupliqué le mesh
des nuages, et créé un nouvel objet "halo" composé d'un seul
vertex, avec un matériau orangé, et l'ai appliqué avec dupli-
vert sur le nuage dupliqué comme je l'ai fait avec l'ampoule.
J'ai alors placé ce nouveau système duplivert sur un autre
calque. Voir l'image 8 pour le système de nœuds de cette scè-
ne.

Comme vous pouvez le voir, j'ai séparé toute la scène en trois
couches de rendu distinctes. Tout d'abord, il y a le calque de
rendu avec le champ d'ampoule (En haut du système de
nœud). Dessus, j'ai utilisé un filtre Defocus pour générer la
profondeur de champ (que j'utilise pendant tout le film), et
aussi un noeud Luminosité/Contraste pour ajouter plus de
contraste à ma scène (un autre truc rapide au lieu d'utiliser
une configuration de lumière plus complexe).

Puis, j'ai "ajouté" un calque de rendu halo au-dessus du cal-
que de l'ampoule. Pour ajouter un peu plus de velouté à ces
halos, je les ai floutté puis j'ai "additionné" le flou du halo
au-dessus des halos rendus. Et j'utilise la même astuce sur le
personnage pour lui donner un meilleur "wow effect» (j'ai
décidé de faire ça, depuis la configuration de l'armature de
base).

Après cela, quand venait le temps d'animer toutes ces ampou-
les et les placer en cercle, j'ai utilisé un truc de cinéma bon
marché. Pendant une coupure entre deux plans, j'ai créé un
nouveau .blend qui contenaient tous les mêmes objets, placé
exactement comme s'ils étaient dans le .blend précédent. Au
lieu d'utiliser seulement duplivert, j'ai aussi utilisé un système
de particules.
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Puisque chaque objet qui composent les nuages (il y avait 3
sections qui formaient les nuages entiers) avaient 1870 verti-
ces, je leur ai ajouté un système de particules pour les 1870
particules émettrices. J'ai ensuite cliqué sur le bouton "From:
Verts" dans le menu particule system (s'assurer que le bouton
"face" est désactivé). J'ai ensuite changé la valeur de début et

de fin des particules respectivement à 0 et 1. Cela fait émettre
l'objet des 1870 particules en même temps avant que l'anima-
tion ne commence à la frame 1. Je me suis assuré qu'il n'y ait
aucune vitesse, ainsi toutes les particules restaient en place
une fois qu'elles émettent. Puis, j'ai utilisé un Empty avec un
"Vortex" du panneau fields et voilà, mes particules se déplacè-
rent lentement formant un cercle. Comme je ne voulais pas
avoir à les étendre à l'infini, j'ai simplement créé un nouveau
.blend avec un cylindre subdivisé en fractale d'environ deux
mille sommets (à ce stade, le nouveau plan n'a pas eu à cor-
respondre parfaitement à la vue précédente).

Conclusion
En conclusion, j'aimerais remercier Jonathan Williamson pour
son aide, les critiques et la motivation qu'il m'a donné au
cours des quelques semaines où j'ai travaillé sur ce film. Pas-
sez par notre site Web http://www.montagestudio.org pour
voir mon court métrage, mais aussi le travail de Jonathan. Si
vous avez une question spécifique sur le projet, ou la deman-
de de certains fichiers, je pourrais toujours vous mettre à dis-
position ce que vous demandez. Ce projet a été créé avec un

esprit ouvert, et je demande au spectateur de rester ouvert
d'esprit tout au long des 5 minutes, je n'ai donc pas vraiment
de raison à ne pas «ouvrir» son contenu. La seule raison pour
laquelle je ne diffuse pas les fichiers pour le moment est le
temps qu'il faudrait pour organiser les dossiers et faire des
fichiers texte expliquant correctement chacun d'eux. Diffuser
autant de dossiers ne serviraient à rien s'ils sont pris hors
contexte, donc je ne suis pas disposé à le faire si je n'ai pas le
temps de bien le faire. Comme je l'ai dit, si vous avez des
demandes particulières, écrivez-moi à
jsguillemette@hotmail.com or
jsguillemette@montagestudio.org.

Voici le .blend de l'ampoule:

http://www.montagestudio.org/Ecks/ProjectLightBulb/lightbulb.
blend

Et voici le personnage de la scène finale,

http://www.montagestudio.org/Ecks/ProjectLightBulb/Character
_LePenseur_jsguillemette.blend

J'espère que vous avez apprécié de lire cet article autant que
j'ai apprécié de l'écrire.

- Jean-Sébastien Guillemette

MAKING OF: ‘A la rencontre de l’oeil alias Projet Lightbulb’
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Introduction
Depuis l'intégration des simulations de flui-
des dans Blender, J'ai été fasciné par le
réalisme obtenu - ça semble parfait. Dans
notre expérience commune, nous nous
attendons à ce qu'un liquide va toujours
bouger sous l'influence de toutes les forces
agissant sur lui, y compris la gravité, jus-
qu'à ce qu'il atteigne finalement un état
stable, s'il en est. Une chose très curieuse à
propos des cascades, par exemple, est que
la forme de la courbe de la chute d'eau
(principalement due à l'élan et à la pesan-
teur) est statique, alors que le débit est
dynamique.

L'art des Fluides : L'idée.
Ce que je n'ai jamais vu parmi tous les exemples de si-
mulations de fluides, c'est quelque chose comme une
fontaine, où l'eau monte sous l'effet de la pression puis
retombe, dessinant une forme d'eau qui ne peut-être
obtenue au repos. Une fontaine sophistiquée serait inté-
ressante du fait de sa complexité accrue. Un simple
exemple de ça dans Blender donnerait:

Plusieurs objets inflow
·  Tous avec la même vitesse de débit vertical (Z)

· Chacun avec une direction horizontale spécifique (X et
Y) pour que l'effet final soit intéressant.

J'ai décidé d'utiliser seize objets inflow, disposés en cer-
cle, comme on le voit ci-dessus, et j'ai dirigé le jet de
chacun vers le haut et vers le centre. Au centre, tous les
cours d'eau entrent en collision et ne cessent de bouger
dans le sens horizontal, de sorte que seuls les mouve-
ments verticaux (vers le bas) restent. Si vous visualisez

cela, c’est comme un arbre avec un tronc et ses bran-
ches.

Point de départ : comment se comporte un flux
de fluide simulé?
À ce stade, ce qu'il faut, ce sont des informations préci-
ses sur la distance et la forme du flux de fluide pour une
vitesse donnée. J'ai fait beaucoup d'expériences avec un
flux pour trouver les bonnes valeurs de vitesse et de géo-
métrie. Voici une capture d'écran d'un résultat satisfaisant
vue de coté. L'inflow était un cube de petite taille pour
faire un jet étroit, ayant une vitesse Z (vers le haut)de 1,
une vitesse X de 1 (positif, à droite), et vitesse Y de 0. Il
est important de noter deux choses: (1) le flux passe de
l'autre coté de l'origine de la grille, alors que plus tard,
l'origine deviendra le centre du cercle des inflow, (2) La
résolution du domaine final du mesh doit être aussi éle-
vée que possible. J'ai pu atteindre une valeur de 200.

MAKING OF: ‘L’art des Fluides – Le Palmier’
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Collision de deux flux : le fluide devient un obsta-
cle.
Pour créer un second jet, j'ai fait
une copie miroir du premier par
rapport à l'origine, fait la simula-
tion et vérifié le résultat d'un
croisement raisonnable des deux
cours d'eau au centre. Les deux
flux fusionnent parfaitement et
coulent vers le bas au centre. Le
second objet inflow avait la mê-
me vitesse Z , mais avec une
vitesse X de -1 (négatif, à gau-
che), et une vitesse Y de 0.

La ramification : faire le calcul
La configuration finale des inflow était un cercle de seize cu-
bes, également répartis sur la
circonférence, centrés à l'origine,
vus d'en haut. Chaque objet
inflow demande le calcul des
composantes de la vitesse en X
et Y, que je n'ai pas inclus ici,
excepté le fait que l'ampleur de
la vitesse horizontale totale était
égal à 1, et que la direction doit
être vers le centre. Le résultat
de cette simulation a abouti à la
forme désirée : un arbre.

Ajouter des couleurs : imiter les matériaux n'est
pas évident.
Comme les fontaines sophistiquées que l'on voit la nuit, les
lumières font parties de l'art. J'ai ajouté des spots colorés à
des endroits stratégiques pour donner des reflets verts sur les
branches, et des lampes "Area" le long du tronc pour des ré-
flexions brunes. La difficulté de cette méthode a été d'éclairer

chaque partie de l'arbre avec une couleur spécifique, sans
chevauchement. Pour profiter pleinement de cet éclairage, j'ai
changé les paramètres du matériau
par défaut. Sous l'onglet Shader, j'ai
fixé la valeur de la réflexion à 1, le
degré de spécularité à 2, et la dure-
té à 1.

Conclusion : et un défi
J'ai fais le rendu de plusieurs secon-
des de cette simulation. Stupéfiant.
Il était évident que l'effet fonction-
nait. Ce projet a été difficile et, en
même temps, amusant. Ce qui satisfait ma curiosité sont les
bons résultats de la fonction de simulation des fluides de
Blender. Et il est fascinant de regarder un liquide qui coule
selon une forme familière, ou au moins, une forme intéres-
sante.

Mon défi pour chaque lecteur est d'essayer différentes formes,
vitesses, lumières, matériaux, et même utiliser les courbes IPO
pour faire varier la vitesse des fluides dans le temps.

Amusez-vous bien!

MAKING OF: ‘L’art des Fluides – Le Palmier’
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Jack Harris

Jack Harris (okchoir) est un ingé-
nieur électricien retraité du Texas du nord,
USA, et utilise Blender depuis 2004. Il aime la
chorale et la lecture, et construit actuellement
une structure en acier pour une maison de
retraite.
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Christian Storay - LucyGALERIE
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Elfak - L’AlchimisteGALERIE
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Kevin Whitfield - Station spacialeGALERIE

58



www.blenderart.org Numéro 16 | Mai 2008 - Wow Factor

Kevin Whitfield - Échappée de l’espaceGALERIE
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Jeepster - StatueGALERIE
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Igor Kekeljevic - Projet GodivaGALERIE
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1. Nous acceptons :
· Tutoriels explicants les nouvelles fonctionnalité de Blender, les concepts 3D, techniques ou

articles basés sur le thème du magazine en cours.
· Reportages sur les évênements de Blender à travers le monde.
· Dessins animés liés au monde de Blender.

2. Envoyer vos  propositions à sandra@blenderart.org. Envoyez-nous un mail
sur ce que vous voulez écrire et nous pourrons faire paraître votre sujet.
(Quelques règles à respecter)

· Les Images sont préférées en PNG mais des JPG de bonnes qualités feront aussi l’affaire. Les
images doivent être jointes séparément du texte.

· Assurez vous que les captures d’écran sont propres, clairs et lisibles et que les rendus sont
d’au moins 800px, et 1600px au maximum.

· Les images séquentielles doivent être nommées ainsi : image 001.png... etc.
· Le texte doit être au format, DOC, TXT ou HTML.
· Les fichiers d’archive au format 7zip ou RAR ou moins préféré zip.

3. Merci d’inclure dans votre email les points suivants :
· Nom: Ce peut être votre nom complet ou votre nom d’avatar de blenderartist.
· Photographie: en PNG avec une taille maximum de 256Px. (Uniquement si c’est votre premier

article)
· Une petite biographie: 25 mots maximum .
· Site Web: (optionel)

Note: Toutes les propositions approuvées peuvent être placées dans l’édition finale ou l’édition
suivante si elle est considérée convenable. Toutes les propositions seront coupées/modifiées si
nécessaire. Pour plus de détails voir le site Web blenderart.
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Vous voulez écrire pour le BlenderArt Magazine?

Voici comment!

mailto:sandra@blenderart.org
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Thème du Prochain Numéro

blenderart.org ne prend aucune responsabilité explicite ou implicite concernant la nature ou
l'exactitude des informations qui sont publiés dans ce magazine PDF. Tous les articles présentés
dans ce magazine PDF ont été reproduit avec la permission exprimée de leurs auteurs/propriétaires
respectifs. Blenderart.org et les collaborateurs n'assurent aucune garanties explicites ou implicites
en incluant, mais sans limiter à une garantie implicite, l'utilisation marchande ou pour un autre but
particulier. Toutes les images et les articles présents dans ce document sont produit/reproduit avec
la permission expresse des auteurs/propriétaires.
Ce magazine PDF est archivé et disponible sur le site blenderart.org. Le magazine blenderart est
disponible sous la licence Creative Commons ‘Attribution-NoDerivs2.5’.

COPYRIGHT© 2007
Les logos ‘BlenderArt Magazine’, ‘blenderart’ et BlenderArt sont sous copyright de Gaurav Nawani.
‘Izzy’ et ‘Izzy logo’ sont sous copyright de Sandra Gilbert. Tous les produits et noms de sociétés
dans cette publication sont des marques ou des marques déposées de leur propriétaires
respectifs.

Disclaimer

Numéro 17 Lumières! Caméra! Action!
· Lumières: Trucs et astuces
· Rendu:  Utilisation des calques de rendu
· Compositing: Rendu pour sortie finale
· Édition Vidéo: Avoir tout ensemble
· Éditeur de séquence
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Blender Clan
www.blenderclan.org

L’équipe de traduction francophone :
(ayant participé à ce numéro)
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Accédez Au Site Wiki Des Traductions

 Flip
 Igabiva
 Ingrid Etienne (Iet) (http://ingrid.cressonniere.be)

Joël Bernis (Bjo) (http://www.bjo.is.free.fr)

 Meltingman

 Newton
 Phil
 PixelVore
 Pascal Hocmard (Alf) (http://www.digitearth.com)

Valérie Hambert (Atymnia)

http://blary.jason.free.fr/wiki/index.php/Accueil
http://www.blenderclan.org
http://blenderart.org

